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SECTION 1 – GENERAL PRINCIPLES

Part A – Introduction

1.1 BACKGROUND

Building Information Modelling (BIM) has been implemented in Hong Kong for several years. At the early stage of development, 

BIM was only voluntarily adopted by some well-established developers, design consultants and contractors. Since 2019, cost 

estimation has been specified by the Development Bureau as one of the mandatory BIM uses in government capital works 

projects. According to CIC BIM Standards – General (Version 2.1 – 2021):

Cost Estimation / 5D modelling is a process in which BIM can be used for cost estimates throughout the life cycle of a 

project.

(a) Quantity Take-off and cost estimating

In the design stage, the Information Models can generate more accurate quantities for project cost budgeting, project 

cost control and cost evaluation on design options, etc. as far as practicable.

In the tender stage, the Information Models can be used for extracting quantities in the preparation of pricing documents 

[and the Information Models shall form part of tender information to indicate the design intent layout and the material 

quantities for the tenderers’ information].

(b) 5D modelling / cash flow forecasting

In the construction stage, the Information Models can be used for extracting quantities for project cost control, cost 

evaluation on the variation of works, cash flow forecast, spending analysis, interim payment, etc. as far as practicable. 

The 5D Model shall be adopted in the regular project progress meetings to indicate and compare the current cash flow 

status with the baseline forecast to facilitate project management.

(Note: the term “information model” is defined under ISO 19650-1:2018.)

In fact, Quantity Take-off (QTO) is the first and foremost essential task for the preparation of pre-construction cost estimates, 

cost plans, bills of quantities, quotations, schedule of quantities and rates, and bills of materials for ordering, programme 

planning, progress payment valuation, post-contract cost estimating, re-measurement of provisional quantities and variations, 

etc. With the advent of BIM, the traditional meaning of QTO, whereby the dimensions of work and materials are measured from 

the drawings one by one and further calculated to give the quantities, should be updated to mean extraction and generation 

of quantities from the BIM models for various cost management needs. Such needs are applicable to any person (not 

just quantity surveyors) who is required to determine the quantities of work to be done (or already done) or materials to be 

ordered, and the quantities so extracted or generated must suit the established practice of classification and itemisation for 

cost management needs.

The quantity surveying discipline has been proactively exploring how to adopt BIM in quantity surveying practices throughout 

the project life cycle. Projects utilising BIM models for QTO, cost estimating and other cost management functions are 

growing. However, there are still many issues to be resolved to achieve a higher degree of collaboration with other disciplines. 

While several BIM standards have been released in the industry, these standards and most of the BIM models being produced 

in projects have not adequately prescribed or been modelled in such a way to enable extraction and generation of quantities 

according to the established practice of classification and itemisation.
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The Digitalisation Sub-committee of the Quantity Surveying Division (QSD) of The Hong Kong Institute of Surveyors (HKIS), 

therefore, took an initiative to prepare this publication listing the QTO information requirements on model elements / objects, 

and QTO guidelines. It is anticipated that this publication will contribute not only to the best practice of BIM-based QTO, but 

also facilitate the collaborative practice among stakeholders. For full automation of QTO, further standardisation or coding 

system has to be explored.

The persons carrying out BIM-based QTO are called “quantity surveyors” in this publication, irrespective of their positions or 

employment in their organizations.

1.2 AIM AND APPROACHES

BIM models of inadequate quality will impair using BIM information for cost management and procurement. Benefits from 

efficient model-based cost advice or budget monitoring cannot be achieved.

This publication aims to give guidelines to be used by quantity surveyors to share and communicate with the designers 

and modellers to ensure that the information provided in BIM models can enable the extraction and generation of quantities 

according to the established practice of classification and itemisation in the pre- and post-contract stages.

The general principles are described in this Part A.

The naming of any specific software or brand name is for explaining the origin of the specific content and does not aim at 

promoting any proprietary product.

Part B presents the common work and trade sections, and describes under each section:

1. Basic modelling approaches: this publication does not mandate the modelling approaches*; most of the models 

included are taken from existing projects and the information for QTO is highlighted for illustration. Geometric modelling 

relationships have been suggested such that the quantities directly generated from the model can represent the 

quantities required for QTO with minimum adjustments. Schedulable parameters should be used as much as possible 

such that the model is truly parametric to avoid the occurrence of a mismatch between the geometry and the input 

parameter value.

* To enable smooth workflow and effective data management across the built asset life cycle, standardisation of 

naming and data format must be agreed upon among different parties. The solution for digitalised workflow is full 

collaboration among different disciplines to explore the appropriate way.

In a BIM project, the full information required for tender pricing and construction should be given in the model, and 

supplementary 2D drawings of construction details and specifications should be provided for study in conjunction (except 

for the design or development to be further done by the contractors, fabricators and suppliers).

2. Information requirements for QTO: the essential information to be included in a specific model element / object / 

specification / drawing / installation detail. The quantity surveyors are also reminded of what is generally not included in 

a model element / object. Please also refer to point 4 below.
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3. QTO guidelines: brief guidelines on how to extract the relevant dimensions or quantities in compliance with the Fifth 

Edition of the Hong Kong Standard Method of Measurement (HKSMM5) to compile schedules for measurement.

Note: The HKSMM5 has been drafted but not yet been released when this document “BIM Measurement Information 

Requirements” is published; quantity surveyors should alert for any final revisions in the HKSMM5 to be launched 

and make necessary adjustments in the BIM QTO based on this document.

Preambles to Part B:

a) All the information highlighted in red rectangular frames in the properties palette (on the left) of model objects has 

to be provided for QTO;

b) Dimensions and locational levels of model objects, which are required as the minimum information for 

construction purposes and thus for QTO, are not repeatedly mentioned again under information requirements for 

QTO;

c) All the information required for the fields in the schedules illustrated in the QTO guidelines have to be provided for 

QTO; and

d) However, the quantities of the modelled objects are subject to further positional, orientation or shape classifications 

with adjectives like internal, external, deep, high, straight, curved, horizontal, vertical, sloping, battering, etc., 

which have not all been detailed in Part B, but should be reflected in the models or schedules as far as possible.

Some essential scheduling, quantity extraction and generation skills for QTO are described in Part C for the reference of 

quantity surveyors.

1.3 CAVEAT

While BIM models can be built progressively (whether by the design consultants, contractors or their BIM consultants), the 

modelling should be appropriate from the very beginning to avoid abortive work. Therefore, the requirements mentioned in this 

publication should be observed at the very beginning.

Quantity surveyors should recognize that preliminary models received for cost estimating are mostly not completed yet. 

Allowances should be made for work reasonably required for the final design but not yet modelled.

The BIM models should be modelled according to the standards, such as those published by the Construction Industry 

Council (CIC), Housing Authority (HA) or Architectural Services Department (ArchSD), prescribed by the services agreements 

or works contracts. The scope and fineness of BIM models as required at different project stages are usually defined in the 

agreements or contracts in terms of the Level of Information Need (LOIN) as defined in the CIC BIM Standards – General 

(Version 2.1 – 2021), which comprises three components: Level of Graphics (LOD-G), Level of Information (LOD-I), and 

Documentation (DOC). LOD-G has four generic levels of graphical representation: LOD-G 100, LOD-G 200, LOD-G 300, and 

LOD-G 400, and LOD-I has five levels, namely LOD-I 100, LOD-I 200, LOD-I 300, LOD-I 400 and LOD-I 500.
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Quantity surveyors should refer to the services agreements and works contracts and other relevant documents such 

as the BIM Execution Plan (BEP) to understand what level of model details could be obtained at each stage of work. It 

should be noted that notwithstanding the specified standards and LOIN, the fundamental principle is that the BIM models 

should be adequate for the intended purposes at different points in time. If they are not, the designers and the modellers 

should be informed of any errors or omissions, if found by the quantity surveyors, for supplement or corrections. For good 

BIM implementation in a project, it is necessary to involve quantity surveyors from the outset to agree on the information 

requirements for cost management purposes in different stages of work.

The Ideal BIM model should ultimately represent the work to be done or already done, sufficiently and accurately, with no 

errors or omissions.

However, BIM models prepared by the design consultants or their BIM consultants may be intended for design authoring, 

design review and drawing generation only and, if given to the tenderers / contractors, are intended to be for reference only 

without any contractual implication. Care should be exercised when using such BIM models for preparing bills of quantities or 

schedules of quantities and rates. This situation is not ideal for the implementation of BIM in construction projects. The HKIS 

BIM Contract Conditions (First Edition, April 2020) has a provision to include “Design Model” as part of contract documents. 

The Development Bureau (DEVB) Technical Circular (Works) No. 2/2021 and its updates dated 13 June 2023 mention that 

it is the goal of DEVB to include BIM models as part of tender information and make them contractually binding, and Works 

Departments shall work towards the goal.

On the other hand, BIM models prepared by the contractors or their BIM consultants may serve different purposes from 

those prepared by the architects or engineers, and these models may contain fabrication details and as-built work which are 

not a measurable item for payment according to the methods of measurement used for the bills of quantities or schedule of 

quantities and rates. Care should be exercised when these BIM models are the only available models for QTO in the post-

contract stage of a project.

When BIM models are built according to the agreed approaches and LOIN, and the BIM models are reviewed by model 

authors to remove errors or omissions, then quantity surveyors should be able to do BIM QTO by extracting information and 

quantities for cost management, effectively from the BIM models. While it may not yet be ideal that the deliverables may be 

generated from the click of a single button, the whole BIM QTO process will be benefited from the automated collection and 

categorization of data, thus facilitating quantity surveyors to provide clients with more active cost advice against any design 

changes in a project.
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Part B –  BIM Model Information Requirements  
for Quantity Take-off

SECTION 2 – EXCAVATION

2.1 SITE AND FOUNDATION EXCAVATION

2.1.1 BASIC MODELLING APPROACHES

(A) Model comparing existing and new toposurfaces:

Create two toposurfaces, one representing the profile of existing / commencing levels and another representing the 

profile of excavated levels. Cut and fill volumes will be generated when the two toposurfaces are compared.

If no existing toposurface object is available, import drawings of existing toposurface for creating the existing 

toposurface object in the model.

By using the building pad approach, quantities of excavation could be derived. Unless otherwise agreed with 

modellers, quantity surveyors will carry out the building pad approach as illustrated in Section 2.1.3.

For site formation:

  
 Figure 2.1.1 – Commencing levels Figure 2.1.2 – Excavated levels

  
  Figure 2.1.3 – Combined profile
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(B) Model with building pad in existing toposurface:

Create a system family type for each type and thickness of building pads, and place the individual object in the design 

location to the required boundary. If different levels of foundation are encountered, create separate building pads.

Methods on how to create toposurface and building pad:

1. Create toposurface

Create New Project.

Open Site Floor Plan.
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Import CAD “SiteTopo.dwg”, select “meter” for import units:

Click “Massing & Site” > “Toposurface”:

Click “Create from Import” > “Select Import Instance”:
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Select the dwg, click “OK” > “Finish Surface”:

Open 3D view, turn to Top plan view.

Click “Graded Region” under Massing & Site tab:

Click “Create a new toposurface exactly like the existing one”:
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Click the toposurface > “Finish Surface”:

2. Create building pad

After having a toposurface, create the Building Pad by drawing the boundary line and clicking “Finish Surface”:

Offset the pad top level to 40000, when the required reduced level is 40300, with the difference of 300mm 

being the pad thickness. Blinding layer is not included for simplicity.
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2.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

a) Site formation and excavation requirements.

b) Foundation layout and profile with levels and dimensions.



14 BIM Measurement Information Requirements 

2.1.3 QUANTITY TAKE-OFF GUIDELINES

Create Topography Schedule:

Select “Family and Type”, “Cut”, “Fill”, and “Net cut/fill” fields:
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For measurement of the volume of excavation, create a schedule with the following fields:

The use of Building Pad for measuring quantities of excavation can be done in two ways:

• Option 1: Model Building Pad to bottom level of pile cap to give total bulk excavation volume:

• Option 2: Model Building Pad to required depths in 2 m depth stages according to HKSMM5:

Adjust for the following as necessary:

• Nil.
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2.2 EXCAVATION AND LATERAL SUPPORTS

2.2.1 BASIC MODELLING APPROACHES

Excavation and lateral support should be modelled in two major parts. One is supporting wall and the other is strutting 

system.

For supporting wall, such as sheet piles, soldier piles, interlocking piles, etc., the modelling approaches and information 

required should refer to “Section 4.1 – Steel Sheet Piling” for details.

For strutting system, including struts, walings, king posts, bracings, etc., the modelling approaches and information 

required should refer to “Section 9 – Structural Steelwork” for details.

Figure 2.2.1 – 3D View of Excavation and Lateral Support (Engineer’s design)
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SECTION 3 – FOUNDATIONS

3.1 RAFT FOUNDATIONS

3.1.1 BASIC MODELLING APPROACHES

Based on the structural foundations template, create a system family type for each type and thickness of foundation 

slabs, and place the individual object in the designed location to the required boundary / profile.

The relevant information that can be extracted from the parameters includes perimeter, area, volume, width, length, 

thickness, etc.

 

In case there is a level difference, through Structure > Slab > Floor: Slab Edge, create a system family type for slab 

edge (soffit step):

 

Figure 3.1.1 – 3D View of Foundation Slabs with

Level Difference
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3.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Foundation marks.

2. Mixes or strengths of concrete.

3. Types and extents of specified admixtures, e.g., waterproofing.

4. Thicknesses of blinding layer.

5. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

3.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of foundations, create a schedule with the following fields:

Set the following formula in the schedule:

• Side Fwk Area = Perimeter * Thickness

• Volume of blinding layer = Area * Thickness of blinding layer, not shown above

For measurement of slab edges (soffit steps), create a schedule with the following fields:

Adjust for the following as necessary:

• Formwork at intersected areas of foundations.

• Formwork and blinding layer at steps.



19BIM Measurement Information Requirements 

SECTION 4 – PILING

4.1 STEEL SHEET PILING

4.1.1 BASIC MODELLING APPROACHES

Based on one of the generic model templates, create a loadable family type for each type and cross-section size of 

steel sheet piling by extruding the specified cross-sectional dimensions and profile, and place the individual object in 

the designed location to the required alignment and top and bottom levels, which may vary depending on the design 

requirements and actual ground conditions.

Set the steel sheet piling length as an instance parameter to enable the adjustment of individual piling depth, while its 

cross-sectional profile is fixed as a type property.

Where there are corner, junction, closure, taper or other special sheet piles, create separate loadable family types for 

them.

The existing ground or formation levels should be created in the model so that there are reference levels for placing the 

sheet piles. When precise existing ground or formation levels are unavailable, tentative levels should be given.

Depending upon the design, sheet piles may be projected above or sunken below the commencing levels.

The relevant information that can be extracted from the parameters includes cross-sectional size, length, depth, 

various levels, etc.

 Figure 4.1.1 – 3D View of Steel Sheet Piling
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Fig 4.1.2 – Elevation View of Steel Sheet Piling

Fig 4.1.3 – Profile of Steel Sheet Piling

4.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Sheet pile marks.

2. Cross-sectional sizes (i.e., widths, heights and thicknesses) and section modulus of sheet piles.

3. Supply (or design) lengths of sheet piles, if designed by the engineer.

4. Commencing levels (which may be existing ground or formation levels) and bottom levels of sheet piles.

5. Any cutting-off surplus lengths be indicated or specified.

This sample model has not included:

a. Initial trenching, temporary strutting, waling and other guides for driving.

b. Pre-boring for sheet piles.

c. Temporary lateral supports to sheet piles.

d. Corner, junction, closure, taper or other special sheet piles.
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4.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of steel sheet pilings, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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4.2 BORED PILES

4.2.1 BASIC MODELLING APPROACHES

Based on the structural foundation template, create a loadable family type for each type and cross-sectional size of 

bored piles by extruding the specified cross-sectional dimensions and profile, and place the individual object in the 

designed location to the required top and bottom levels, which may vary depending on the design requirements and 

actual ground conditions.

Set the relevant bored pile dimensions as instance parameters to enable the adjustment of individual length, diameter, 

permanent steel lining, and bell-out.

The existing ground or formation levels should be created in the model so that there are reference levels for placing the 

bored piles. When precise existing ground or formation levels are unavailable, tentative levels should be given.

The relevant information that can be extracted from the parameters includes cross-sectional size, length, depth, 

various levels, etc.

 Fig 4.2.1 – 3D View of Bored Pile
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Fig 4.2.2 – Profile of design dimensions
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4.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Bored pile marks.

2. Nominal diameters of piles and enlarged bases.

3. Commencing levels (which may be existing ground or formation levels), cut-off levels, top levels of bedrock and 

bottom levels of bored piles.

4. Bottom levels of specified pile sleeving and permanent linings.

5. Mixes or strengths of concrete fillings to pile holes.

6. Socket lengths in bedrock.

7. Internal diameters and thicknesses of permanent linings.

This sample model has not included:

a. Reinforcement and couplers to piles.

b. Non-destructive integrity tests.

c. Drilling and coring tests.

d. Load tests.

4.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of bored piles, create a schedule with the following fields:

Set the following formula in the schedule:

• Volume of Piles = Net length of Pile * π * (Pile Diameter / 2) 2

Adjust for the following as necessary:

• Nil.
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4.3 STEEL H-PILES

4.3.1 BASIC MODELLING APPROACHES

Based on the structural foundation template, create a loadable family type for each type and cross-sectional size of 

steel H-piles by extruding the specified cross-sectional dimensions and profile, and place the individual object in the 

designed location to the required top and bottom levels, which may vary depending on the design requirements and 

actual ground conditions.

Set the relevant steel H-pile dimensions as instance parameters to enable the adjustment of individual length, member 

size, raking angle, etc.

The existing ground or formation levels should be created in the model so that there are reference levels for placing the 

steel H-piles. When precise existing ground or formation levels are unavailable, tentative levels should be given.

The relevant information that can be extracted from the parameters includes cross-sectional size, length, depth, 

various levels, etc.

 Fig 4.3.1 – 3D View of Steel H-Pile



26 BIM Measurement Information Requirements 

 Fig 4.3.2 – Profile of Steel H-pile Fig 4.3.3 – Elevation view of Steel H-pile

4.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Steel H-pile marks.

2. Cross-sectional sizes and weights per unit length.

3. Commencement levels, cut-off levels and bottom levels of steel H-piles.

4. Pile head details.

This sample model has not included:

a. Pre-boring.

b. Drilling test.

c. Load tests.
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4.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of steel H-piles, create a schedule with the following fields:

Set the following formula in the schedule:

• Weight (of Piles) = Pile Length / 1000 * Unit Weight per Linear (Length)

Adjust for the following as necessary:

• Nil.
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4.4 ROCK-SOCKETED STEEL H-PILES

4.4.1 BASIC MODELLING APPROACHES

Based on the structural foundations template, create a loadable family type for each type and cross-sectional size of 

rock-socketed steel H-piles by extruding the specified cross-sectional dimensions and profile, and place the individual 

object in the designed location to the required top and bottom levels, which may vary depending on the design 

requirements and actual ground conditions.

Set the relevant rock-socketed steel H-pile dimensions as instance parameters to enable the adjustment of individual 

length, member size, raking angle, etc.

The existing ground or formation levels should be created in the model so that there are reference levels for placing the 

rock-socketed steel H-piles. When precise existing ground or formation levels are unavailable, tentative levels should 

be given.

The relevant information that can be extracted from the parameters includes diameter, length, depth, various levels, 

etc.

  Fig 4.4.1 – 3D View of Rock-Socketed H-Pile
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 Fig. 4.4.2 – Elevation View of Rock-Socketed H-Pile Fig. 4.4.3 – Plan View of Rock-Socketed H-Pile
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4.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Rock-socketed steel H-pile marks.

2. Nominal diameters of sockets.

3. Commencing levels (which may be existing ground or formation levels), cut-off levels, top levels of bedrock and 

bottom levels of rock-socketed H-piles.

4. Internal diameters and thicknesses of permanent casings.

5. Mixes or strengths of concrete fillings to pile holes.

6. Socket lengths in bedrock.

7. Pile head details.

This sample model has not included:

a. Reinforcement to piles.

b. Pre-boring and drilling tests.

c. Load tests.

4.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of rock socketed steel H-piles, create a schedule with the following fields:

Set the following formula in the schedule:

• Drilling Length = Commencement Level – Bottom Level of Pile

Adjust for the following as necessary:

• Nil.
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4.5 MINI-PILES

4.5.1 BASIC MODELLING APPROACHES

Based on the structural foundation templates, create a loadable family type for each type and cross-sectional size 

of mini-piles by extruding the specified cross-sectional dimensions and profile, and place the individual object in the 

designed location to the required top and bottom levels, which may vary depending on the design requirements and 

actual ground conditions.

Set the relevant mini-pile dimensions as instance parameters to enable the adjustment of individual length, diameter, 

raking angle, etc.

The existing ground or formation levels should be created in the model so that there are reference levels for placing the 

mini-piles. When precise existing ground or formation levels are unavailable, tentative levels should be given.

The relevant information that can be extracted from the parameters includes diameter, length, depth, various levels, 

etc.

  Fig. 4.5.1 – 3D View of Mini-Pile
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 Fig. 4.5.2 – Elevation view of Mini-Pile Fig. 4.5.3 – Plan View Of Mini-Pile
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4.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Mini-pile marks.

2. Nominal diameters of piles.

3. Diameters of steel bars.

4. Commencing levels (which may be existing ground or formation level), cut-off levels, top levels of bedrock and 

bottom levels of mini-piles.

5. Internal diameters and thicknesses of permanent casings.

6. Mixes or strengths of concrete fillings to pile holes.

7. Socket lengths in bedrock.

8. Pile head details.

This sample model has not included:

a. Load tests.

4.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of mini-piles, create a schedule with the following fields:

Set the following formula in the schedule:

• Drilling Length = Commencement Level – Bottom Level of Pile

Adjust for the following as necessary:

• Nil.
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4.6 DIAPHRAGM WALLING

4.6.1 BASIC MODELLING APPROACHES

A diaphragm wall consists of two 3D segments: (1) panel lengths in soil and (2) panel lengths in rock.

Based on the structural foundations template, create a loadable family type for each type of “panel lengths in soil” by 

extruding the specified cross-sectional dimensions and profile, and place the individual object in the designed location 

to the required alignment and top and bottom levels, which may vary depending on the design requirements and actual 

ground conditions.

Set the cut-off level of the diaphragm wall panel as the top level of diaphragm wall panels. Set the panel width, 

thickness and length as instance parameters to enable the adjustment of individual dimensions where necessary.

Create the second 3D segment (i.e., panel length in rock (bedrock)) in the same way as the first segment.

Lock the two segments together. Where there are corner or other non-standard panels, create separate loadable family 

types for them.

The existing ground or formation levels should be created or indicated so that there are reference levels for placing the 

guide walls and diaphragm wall panels.

Create guide walls separately based on the wall system family.

Unless otherwise designed or specified, excavation trenches for diaphragm wall panels are commenced at the bottom 

levels of guide walls (instead of the cut-off or top levels of panels).

The relevant information that can be extracted from the parameters includes thickness, length, depth, volume, etc.
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  Figure 4.6.1 – 3D View of Diaphragm Wall

Figure 4.6.2 – Cross-Section View of Diaphragm Wall
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Figure 4.6.3 – Elevation of Diaphragm Wall
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4.6.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Diaphragm wall marks.

2. Mixes or strengths of concrete.

3. Commencing levels for excavation of guide walls and diaphragm walls.

4. Dimensions of guide walls (if not modelled); required on one side or both sides.

5. Top levels of bedrock.

This sample model has not included:

a. Guide walls.

b. Reinforcement to diaphragm walls.

c. Waterproof joints between panels.

d. Pre- and post-construction drilling tests.

e. Temporary lateral supports.

4.6.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of diaphragm walling, create a schedule with the following fields:

Set the following formulae in the schedule:

• Concrete volume = Panel width * Panel thickness * Panel length

• Excavation volume = Excavation depth * Panel width * Panel thickness

Adjust for the following as necessary:

• Nil.
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SECTION 5 – RC SUBSTRUCTURE

5.1 PILE CAPS

5.1.1 BASIC MODELLING APPROACHES

Based on the structural foundation templates, create a system family type for each type and thickness of pile caps, 

and place the individual object in the designed location to the required boundary / profile.

The relevant information that can be extracted from the parameters includes perimeter, (horizontal) area, volume, width, 

length, thickness (height), etc.

Model pile head embedment to cut through pile caps, i.e. the piles should take precedence over pile caps.

 

  Figure 5.1.1 – 3D View of Pile Cap
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5.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Pile cap marks.

2. Mixes or strengths of concrete.

3. Types and extents of specified admixtures (if any).

4. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

5.1.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of pile caps, create a schedule with the following fields:

Set the following formulae in the schedule:

• Pile Cap Side Fwk Area = Perimeter * Thickness (depth of pile cap)

• Volume of blinding layer = Area * Thickness of blinding layer, not shown above

Adjust for the following as necessary:

• Omit formwork at intersections of pile caps and other pile caps or footings.

• Omit areas of blinding layers overlapped with piles.
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5.2 BASEMENT PERIMETER WALLS

5.2.1 BASIC MODELLING APPROACHES

Based on the structural walls template, create a system family type for each type and thickness of basement perimeter 

walls, and place the individual object in the designed location to the required alignment and top and base levels.

The relevant information that can be extracted from the parameters includes thickness, unconnected height (height), 

length, area, volume, etc. The parameter “area” may only be useful if the wall is a straight wall, otherwise, the area 

represents the largest area of the wall.

Model basement walls to cut through attached beams, slabs and staircases.

Generally, the structural top levels of the basement bottom slabs should be the base levels of the perimeter walls, and 

the structural top levels of the basement top slabs should be the top levels of the perimeter walls.

Set the corner wall joint method consistently as this will affect the allocation of wall type, concrete volume and 

formwork areas between different wall thicknesses joined together.

 

 

  Figure 5.2.1 – 3D View of Basement Wall
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5.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Wall marks.

2. Wall types – structural / retaining / vertical / sloping / curved.

3. Mixes or strengths of concrete.

4. Formwork type – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

5.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of basement perimeter walls, create a schedule with the following fields:

Set the following formulae in the schedule:

• Fwk_Sides of wall = Area * 2, only for straight walls without turns since Area = external face area.

• Fwk_Sides of wall = Volume / Width (i.e. thickness) * 2, more accurate based on average centre line area whether 

it is a straight or turned wall and whether it has varying widths or heights.

Adjust for the following as necessary:

• Omit formwork at intersections of walls with slabs, beams or columns as appropriate (except ends of beams and 

non-structural walls).

• Left-in formwork or one-sided formwork.
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5.3 SUBSTRUCTURE COLUMNS

5.3.1 BASIC MODELLING APPROACHES

Based on the structural columns template, create a loadable family type for each type and cross-sectional size of 

substructure columns, and place the individual object in the designed location to the required top and base levels.

The relevant information that can be extracted from the parameters includes b (column breadth), h (column depth), 

length (column height), volume, etc.

Model columns to cut through attached beams, slabs and staircases, i.e. the column geometry should take precedence 

over them.

Generally, the base levels should be the structural top levels of the footings (or pedestals) on which the columns rest, 

and the top levels should be the structural top levels of the lowest floor slabs above.

 
  Figure 5.3.1 – 3D View of Substructure Column
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5.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Column marks.

2. Column types – vertical or inclined (or slanted).

3. Mixes or strengths of concrete.

4. Shapes and cross-sectional sizes of columns

5. Types and extents of specified admixtures (if any).

6. Formwork type – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork

5.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of substructure columns, create a schedule with the following fields:

Set the following formulae in the schedule:

• Fwk_Sides of Column = Length * (ColumnBreadth + ColumnDepth) * 2, for rectangular columns

• Fwk_Sides of Column = Length * π * ColumnDiameter, for round columns, not shown above

Note:

• Refer to Part C for how to set ColumnBreadth and ColumnDepth as schedulable shared parameters.

Adjust for the following as necessary:

• Omit formwork at intersections of columns with slabs or structural walls as appropriate.
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5.4 SUBSTRUCTURE BEAMS

5.4.1 BASIC MODELLING APPROACHES

Substructure beams can be divided into ground beams, strap beams and tie beams.

Based on the structural template, create a loadable family type for each type and cross-sectional size of ground 

beams, strap beams and tie beams, and place the individual object in the designed location to the required alignment 

and length.

The relevant information that can be extracted from the parameters includes b (beam width), h (beam depth), cut length 

(beam length), volume, etc.

Model substructure beams to be cut through by structural walls and columns.

The substructure beams should be modelled to the full structural size of the width and depth#.

#The submissions to the Buildings Department require slabs to be modelled between beams.
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Figure 5.4.1 – 3D View of Substructure Beam

Figure 5.4.2 – Elevation of Substructure Beam

 

Beam depth 
under slab 
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5.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Beam marks.
2. Beam types – ground beam / strap beam / tie beam / horizontal / sloping / curved / cranked / tapered.
3. Mixes or strengths of concrete.
4. Cross-sectional sizes of beams.
5. Types and extents of specified admixtures (if any).
6. Formwork type – left-in (if any).

This sample model has not included:
a. Blinding layer.
b. Reinforcement.
c. Formwork

5.4.3 QUANTITY TAKE-OFF GUIDELINES

For quantity take-off of on-grade substructure beams, create a schedule with the following fields:

For volume of beam, set the following formulae in the schedule:
• Volume (of Beam) (m3) = Cut Length * BeamWidth * BeamDepth.

For an edge beam as illustrated in Figure 5.4.2, set the following formulae in the schedule:
• Fwk_Sides of Beam (m2) = Cut Length * (BeamDepth + BeamDepth under slab).

For beams with slab concrete cast between beams, set the following formulae in the schedule:
• Fwk_Sides of Beam (m2) = Cut Length * (BeamDepth under slab*2).

Note:
• Refer to Part C for how to set BeamDepth (h) and BeamWidth (b) as schedulable shared parameters, otherwise 

they are not obtainable using Schedule by default.

Adjust for the following as necessary:

• Omit formwork at intersections of beams with slabs or structural walls as appropriate (except ends of beams).
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5.5 SUBSTRUCTURE SLABS

5.5.1 BASIC MODELLING APPROACHES

Substructure slabs (called “floors” in Revit) can be divided into basement slabs, on-grade slabs and suspended slabs. 

All slabs can be built up based on existing structural floors families.

Create a system family type for each type and thickness of substructure slabs, and place the individual object in the 

designed location to the required boundary.

The relevant information that can be extracted from the parameters includes perimeter, thickness, area, volume, etc.

Substructure slab is defined as horizontal element. The slab is bounded by beams or vertical elements (e.g., structural 

columns and walls).

Model substructure slabs to be cut through by beams#, walls and columns.

#The submissions to the Buildings Department require slabs to be modelled between beams.

 

 Figure 5.5.1 – 3D View of Substructure Slab
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5.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Slab marks.

2. Slab types – suspended / on-grade / ground slab / sloping.

3. Mixes or strengths of concrete.

4. Thickness of slabs.

5. Types and extents of specified admixtures (if any).

6. Formwork – left-in (if any).

This sample model has not included:

a. Blinding layer.

b. Hardcore bed and building paper.

c. Reinforcement.

d. Formwork.

5.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of substructure slabs, create a schedule with the following fields:

Set the following formula in the schedule:

• Fwk_Sides of Slab (i.e., area of edges of slabs) = Thickness (i.e. height) * Perimeter

Adjust for the following as necessary:

• Omit formwork at intersections of slabs with structural walls and columns, beams, footings or pile caps as 

appropriate.
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SECTION 6 – RC SUPERSTRUCTURE

6.1 STRUCTURAL COLUMNS

6.1.1 BASIC MODELLING APPROACHES

Based on the structural columns template, create a loadable family type for each type and cross-sectional size of 

structural columns, and place the individual object in the designed location to the required top and base levels.

The relevant information that can be extracted from the parameters includes b (column width), h (column depth), length 

(column height), volume, etc.

Model columns to cut through attached beams, slabs and staircases, but not to cut through transfer slabs and beams.

Generally, the structural floor levels should be used as the top levels of columns below and the base levels of columns 

above, except that the base levels of transfer slabs and beams should be used as the top levels of columns below.

 

 
 Figure 6.1.1 – 3D View of Structural Column
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6.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Column marks.

2. Column types – structural / vertical / sloping / rectangular / circular.

3. Mixes or strengths of concrete.

4. Cross-sectional sizes of columns.

5. Types and extents of specified admixtures (if any).

6. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of structural columns, create a schedule with the following fields:

Set the following formulae in the schedule:

• Fwk_Sides of Column = Length * (Column Width + Column Depth) * 2, for rectangular columns

• Fwk_Sides of Column = Length * π * Column Diameter, for round columns not shown above

Note:

• Refer to Part C for how to set Column Width and Column Depth as schedulable shared parameters.

Adjust for the following as necessary:

• Omit formwork at intersections of columns with slabs, beams or structural walls as appropriate (except ends of 

beams).



51BIM Measurement Information Requirements 

6.2 STRUCTURAL WALLS

6.2.1 BASIC MODELLING APPROACHES

Based on the structural walls template, create a system family type for each type and thickness of structural walls, and 

place the individual object in the designed location to the required alignment and top and base levels.

The relevant information that can be extracted from the parameters includes length, width (thickness), unconnected 

height (height), area, volume, etc.

Model structural walls to cut through attached beams, slabs and staircases, but not to cut through transfer slabs and 

beams.

Generally, the structural floor levels should be used as the top levels of structural walls below and the base levels of 

structural walls above, except that the base levels of transfer slabs and beams should be used as the top levels of 

structural walls below.

Set the corner wall joint method consistently as this will affect the allocation of concrete volume and formwork areas 

between different wall thicknesses joined together.

 

 
 Figure 6.2.1 – 3D View of Structural Wall
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6.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Wall marks.

2. Wall types – structural / retaining / vertical / sloping / curved.

3. Mixes or strengths of concrete.

4. Wall thicknesses.

5. Types and extents of specified admixtures (if any).

6. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of structural walls, create a schedule with the following fields:

Set the following formulae in the schedule:

• Fwk_Both sides of Wall = Area * 2, only for straight walls without turns since Area = external face area

• Fwk_Both sides of Wall = Volume / Width (i.e., thickness) * 2, more accurate based on average centre line area 

whether it is a straight or turned wall and whether it has varying widths or heights

Adjust for the following as necessary:

• Omit formwork at intersections of walls with slabs, beams or columns as appropriate (except ends of beams and 

non-structural walls).

• Edges, breaks and ends of walls.
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6.3 STRUCTURAL BEAMS

6.3.1 BASIC MODELLING APPROACHES

Based on the structural framings template, create a loadable family type for each type and cross-sectional size of 

beams, and place the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters includes cut length (beam length), b (beam width), 

h (beam depth), volume, etc.

Model beams to be cut through by structural walls and columns.

The structural beams should be modelled to the full structural size of the width and depth#.

#The submissions to the Buildings Department require slabs to be modelled between beams.

 
 Figure 6.3.1 – 3D View of Beam
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6.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Beam marks.

2. Beam types – horizontal / sloping / curved / cranked / tapered / upstand / transfer beam / tie beam.

3. Mixes or strengths of concrete.

4. Cross-sectional sizes of beams.

5. Types and extents of specified admixtures (if any).

6. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of beams, create a schedule with the following fields:

Beam depth 

under slab
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Set the following formulae in the schedule:

For volume of beam:

• Volume (of Beam) (m3) = Cut Length * BeamWidth * BeamDepth.

For formwork to beam:

• Beam depth under slab = Beam Depth – Slab Thickness, where Slab Thickness, not shown in the above schedule, 

is a field entered manually

• Fwk_Sides & Soffit = Cut Length * (Beam Depth under slab* 2 + Beam Width)

Note:

• Refer to Part C for how to set Beam Width and Beam Depth as schedulable shared parameters.

• There is an alternative rule under HKSMM5 that the volumes of slabs and beams can be measured and grouped 

together if they are of the same mix or strength. The alternative rule applies only if expressly so stated.

Adjust for the following as necessary:

• Omit formwork at intersections of beams with slabs or structural walls as appropriate (except ends of beams).
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6.4 STRUCTURAL SLABS

6.4.1 BASIC MODELLING APPROACHES

Based on the structural floors template, create a system family type for each type and thickness of slabs, and place 

the individual object in the designed location to the required boundary.

The relevant information that can be extracted from the parameters includes perimeter, thickness, area, volume, etc.

Model slabs to be cut through by beams#, walls and columns.

#The submissions to the Buildings Department require slabs to be modelled between beams.

 
 Figure 6.4.1 – 3D View of Slabs
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6.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Slab marks.

2. Slab types – suspended / sloping / curved.

3. Thickness of slabs.

4. Mixes or strengths of concrete.

5. Types and extents of specified admixtures (if any).

6. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of slabs, create a schedule with the following fields:

Set the following formula in the schedule:

• Fwk_Soffit of Slab = Area

Note:

• HKSMM5 stipulates that slab concrete volumes are measured across beams. According to the above modelling 

approach, the default parameters Volume and Area of slabs do not include the portions over beams. Adjustments 

of Volume to give slab concrete volume are required to follow the HKSMM5 rules.

• There is an alternative rule in the HKSMM5 that the volumes of slabs and beams may be measured and grouped 

together if they are of the same mix or strength. The alternative rule applies only if expressly so stated.

Adjust for the following as necessary:

• Omit formwork at intersections of slabs with columns, structural walls or beams as appropriate (except ends of 

beams and non-structural walls).

• Add formwork to edges and breaks in slabs if required.
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6.5 STAIRCASES

6.5.1 BASIC MODELLING APPROACHES

Based on the stairs template, create a system family type for each type and cross-sectional size of staircases, and 

place the individual object in the designed location to the required length and top and base levels.

The relevant information that can be extracted from the parameters includes actual number of risers, actual riser height, 

actual tread width, etc.

Create In-place models to complete the connections to structural elements.

 

 Stair Connection 01 Stair Connection 02

Figure 6.5.1 – 3D View of Staircase 02
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6.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Staircase marks.

2. Staircase types.

3. Mixes or strengths of concrete.

4. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of concrete staircases, create a material take-off schedule with the following fields (refer to Part C for 

how to create material take-off schedules):

For measurement of the in-place models of stair connections, create a schedule with the following fields:
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For measurement of formwork to open strings and soffits of stairs, use the “Paint” tool to assign different material 

surfaces.

Figure 6.5.2 – 3D View of Staircase 01

After using the Paint tool, create a material take-off schedule with the following fields (refer to Part C for how to create 

material take-off schedules):
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For measurement of formwork to risers of stairs, create a schedule with the following fields:

Set the following formula in the schedule:

• Fwk_Riser of Stair (area) = (Actual Number of Risers – 1) * Stair Width * Actual Riser Height, 1 riser subtracted 

when the upper landing edge is modelled as 1 riser

Note:

• Open string and riser measured in m2; formwork ≤ 300mm or > 300mm high should be stated separately 

according to HKSMM5.

Adjust for the following as necessary:

• Nil.
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6.6 CURBS

6.6.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type and thickness of curbs, and place the individual 

object in the designed location to required alignment, length and height.

The relevant information that can be extracted from the parameters includes length, width, unconnected height (height), 

area, volume, etc.

 

 
 Figure 6.6.1 – 3D View of Curb
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6.6.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Curb marks.

2. Mixes or strengths of concrete.

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.6.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of curbs, create a schedule with the following fields:

Set the following formula in the schedule:

• Formwork – Sides of curbs (area) = Length * Unconnected Height* 2, or

• Formwork – Sides of curbs (area) = Area * 2

Note

• Measured in m2; formwork ≤ 300mm or > 300mm high should be stated separately according to HKSMM5.

Adjust for the following as necessary:

• Nil.
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6.7 LINTELS (NORMALLY THIS WILL NOT BE MODELLED)

6.7.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type and cross-sectional size of lintels, and place 

the individual object in the designed location to the required alignment and length.

For detailed illustration, refer to Section 8.1.

6.8 MASS CONCRETE FILLING

6.8.1 BASIC MODELLING APPROACHES

Based on the floors template, create a system family type for each type and thickness of mass concrete filling, and 

place the individual object in the designed location to the required boundary.

The relevant information that can be extracted from the parameters includes perimeter, thickness, area, volume, etc.

 
 Figure 6.8.1 – 3D View of Mass Concrete Filling
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6.8.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Mass concrete filling marks.

2. Mixes or strengths of concrete.

This sample model has not included:

a. Formwork.

6.8.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of mass concrete filling, create a schedule with the following fields:

Set the following formulae in the schedule:

• Fwk_Sides of Mass Conc. (area) = Thickness * Perimeter

Note:

• Measured in m2; formwork ≤ 300mm or > 300mm high should be stated separately according to HKSMM5.

Adjust for the following as necessary:

• Nil.
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6.9 SURFACE WATER CHANNELS

6.9.1 BASIC MODELLING APPROACHES

Based on the railings template, create a system family type for each type and cross-sectional size of surface water 

channels by editing the rail and baluster components of the railing to become a channel, and place the individual object 

in the designed location to the required alignment. Pick a host for automatic alignment.

This sample model is just one of the different modelling approaches for surface water channels. The reason to create 

the object based on railings is that it will be easier to draw the channel alignment which can be straight or curved.

The relevant information that can be extracted from the parameters includes cross-sectional size, length, etc.

 Figure 6.9.1 – 3D View of Surface Water Channel

Figure 6.9.2 – Cross-Sectional Profile of Surface Water Channel
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6.9.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Surface water channel marks.

2. Shapes, widths and average depths.

3. Mixes or strengths of concrete.

4. Cover details, if any.

5. Curved.

6.9.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of surface water channels, create a schedule with the following fields:

Note:

• When creating the relevant schedule, while the family name “railing” is still being used, the schedule title should be 

revised from “Railing Schedule” to “Surface Water Channel Schedule”.

Adjust for the following as necessary:

• Nil.
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6.10 NON-STRUCTURAL WALLS

6.10.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type and thickness of non-structural walls, and place 

the individual object in the designed location to the required alignment and top and base levels.

The relevant information that can be extracted from the parameters includes length, unconnected height (height), width 

(thickness), area, volume, etc.

Model non-structural walls to the areas bounded by structural members.

Set the top attachment levels of the non-structural walls up to beam or slab soffits.

Set the corner wall joint method consistently as this will affect the allocation of concrete volume and formwork areas 

between different wall thicknesses joined together.

 

 
 Figure 6.10.1: – 3D View of Non-structural Walls
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6.10.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Wall marks.

2. Wall types – non-structural.

3. Mixes or strengths of concrete.

4. Formwork – left-in (if any).

This sample model has not included:

a. Reinforcement.

b. Formwork.

6.10.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of non-structural walls, create a schedule with the following fields:

Set the following formulae in the schedule:

• Fwk_Both sides of Wall = Area * 2, only for straight walls without turns since Area = external face area

• Fwk_Both sides of Wall = Volume / Width (i.e., thickness) * 2, more accurate based on average centre line area 

whether it is a straight or turned wall and whether it has varying widths or heights

Adjust for the following as necessary:

• Edges, breaks and ends of walls.
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SECTION 7 – PRECAST CONCRETE

7.1 FAÇADE PANELS

7.1.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of precast façade panels 

complete with all the components, and place the individual object in the designed location.

For modelling surface finishes, refer to Section 20.1.1 for details. For modelling built-in fixtures and fittings, refer to 

relevant sections for details.

The dimensions stated in the Type Name should be the overall dimensions of the object.

 

 
 Figure 7–.1.1 – 3D Precast I Panel
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7.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Facade panel marks.

2. Facade panel types.

3. Overall sizes including thicknesses. Required shapes including recesses, sleeves and boxouts.

4. Mixes or strengths of concrete.

5. Surface finishes.

6. Any built-in fixtures and fittings including doors, windows and building services, etc.

7. Any cast-in accessories.

This sample model has not included:

a. Reinforcement. Pre/post-tensioning. Lifting inserts.

b. Structural connections. Joint details.

c. Weatherproof systems and joints.

d. Requirements on moulds.

e. Building services connections.

7.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of precast facade panels, create a schedule with the following fields:

The precast façade panel is deemed to have included, apart from others, surface finishes and built-in fittings and 

fixtures.

Note:

• For measurement of built-in fixtures and fittings separately, refer to the relevant sections for details.

• For measurement of surface finishes separately, refer to Section 20.1.3 for details.

Adjust for the following as necessary:

• Nil.
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7.2 PRECAST SLABS

7.2.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of precast slabs complete 

with all the components, and place the individual object in the designed location.

For modelling surface finishes, refer to Section 20.1.1 for details. For modelling built-in fixtures and fittings, refer to 

relevant sections for details.

The dimensions stated in the Type Name should be the overall dimensions of the object.

 

 
 Figure 7–.2.1 – 3D View of Precast Slab
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7.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Precast slab marks.

2. Precast slab types.

3. Overall sizes including thicknesses. Required shapes including recesses, sleeves and boxouts.

4. Mixes or strengths of concrete.

5. Surface finishes.

6. Any built-in building services, etc.

7. Any cast-in accessories.

This sample model has not included:

a. Reinforcement. Pre/post-tensioning. Lifting inserts.

b. Structural connections. Joint details.

c. Weatherproof systems and joints.

d. Requirements on moulds.

e. Building services connections.

7.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of precast slabs, create a schedule with the following fields:

The precast slab is deemed to have included, apart from others, surface finishes.

Note:

• For measurement of surface finishes separately, refer to Section 20.1.3 for details.

Adjust for the following as necessary:

• Nil.
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7.3 PRECAST STAIRCASES

7.3.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of precast staircases 

complete with all the components, and place the individual object in the designed location.

For modelling surface finishes, refer to Section 20.1.1 for details. For modelling tactile, refer to Section 20.3.1 for 

details.

The dimensions stated in the Type Name should be the overall dimensions of the object.

 

 
 Figure 7.3.1 – 3D View of Precast Staircase

 
Figure 7.3.2 – Plan View of Precast Staircase Figure 7.3.3 – Sectional View of Precast Staircase
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7.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Precast staircase marks.

2. Precast staircase types.

3. Overall sizes including thicknesses. Required shapes including recesses, sleeves and boxouts.

4. Mixes or strengths of concrete.

5. Surface finishes.

6. Any cast-in accessories.

This sample model has not included:

a. Reinforcement. Pre/post-tensioning. Lifting inserts.

b. Structural connections. Joint details.

c. Weatherproof systems and joints.

d. Requirements on moulds.

7.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of precast staircases, create a schedule with the following fields:

The precast staircase item is deemed to include, apart from others, surface finishes and tactile.

Note:

• For measurement of surface finishes separately, refer to Section 20.1.3 for details.

• For measurement of tactile separately, refer to Section 20.3.3 for details.

Adjust for the following as necessary:

• Nil.
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7.4 VOLUMETRIC PRECAST CONCRETE UNITS

7.4.1 BASIC MODELLING APPROACHES

Based on one of the generic model templates, create a loadable family type for each type and size of volumetric 

precast concrete unit complete with all the components, and place the individual object in the designed location.

For modelling surface finishes, refer to Section 20.1.1 for details. For modelling built-in fixtures and fittings, refer to 

relevant sections for details.

The dimensions stated in the Type Name should be the overall dimensions of the object.

 

 
 Figure 7.4.1 – 3D View of Volumetric Precast Concrete Unit

Figure 7.4.2 – Elevation View of Volumetric Precast Concrete Unit



77BIM Measurement Information Requirements 

7.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Volumetric precast concrete unit marks.

2. Volumetric unit types.

3. Overall sizes. Required shapes including recesses, sleeves and boxouts.

4. Mixes or strengths of concrete.

5. Surface finishes.

6. Any built-in fixtures and fittings including doors, windows, sanitary fittings and building services, etc.

7. Any cast-in accessories.

This sample model has not included:

a. Reinforcement. Pre/post-tensioning. Lifting inserts.

b. Structural connection. Joint details.

c. Weatherproof systems and joints.

d. Requirements on moulds.

e. Building services connections.

7.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of volumetric precast concrete units, create a schedule with the following fields:

The volumetric precast concrete unit is deemed to include, apart from others, surface finishes and built-in fixtures and 

fittings.

Note:

• For measurement of built-in fixtures and fittings separately, refer to the relevant sections for details.

• For measurement of surface finishes separately, refer to Section 20.1.3 for details.

Adjust for the following as necessary:

• Nil.
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SECTION 8 – MASONRY

8.1 BRICKWORK AND BLOCKWORK

8.1.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type and thickness of brick walls / block walls / 

panel walls, and place the individual object in the designed location to the required alignment and top and base levels.

The relevant information that can be extracted from the parameters includes wall type, length, unconnected height 

(height), width (thickness), area, etc.

The top of the brick wall / block wall / panel wall is below the horizontal elements (e.g., beam, slab, etc.).

Set the top attachment levels or switch the join-order with beams and slabs such that the wall brick or block area is up 

to beam or slab soffits only.

Set the corner wall joint method consistently as this will affect the allocation of brick or block areas between different 

wall thicknesses joined together.

 
 Figure 8.1.1 – 3D View of Brick / Block Wall
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Lintel, if created on top of the door opening, would be overlapped with the brick/block walls. If lintel is modelled, 

information on the details for respective openings or locations shall be provided.

  
 Figure 8.1.2 – Lintel on Top of Door Opening
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8.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

• Wall marks.

• Wall types.

• Materials, qualities, construction and laying methods.

• Wall thicknesses.

• FRP and insulation properties.

• Damp-proof courses (if any).

• Reinforcement (if any).

• Stiffeners for walls exceeding a specified height (if any).

• Lintels, with cross-sectional sizes, lengths of end laps, concrete mixes and reinforcement details (if any).

8.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of masonry, create a schedule with the following fields:

For measurement of lintels, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 9 – STRUCTURAL STEELWORK

9.1 STEEL COLUMNS

9.1.1 BASIC MODELLING APPROACHES

Based on the structural columns template, create a loadable family type for each type and cross-sectional size of steel 

columns, and place the individual object in the designed location to the required top and base levels.

The relevant information that can be extracted from the parameters includes cross-sectional size, length, unit weight 

per linear length, volume, etc.

 

 
 Figure 9.1.1 – 3D View of Steel Column
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9.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Steel column marks.

2. Cross-sectional sizes and unit weights per length.

3. Types and grades of materials.

4. Surface treatments and finishes.

5. Castellated/tapered/curved/cambered.

9.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of steel columns, create a schedule with the following fields:

Set the following formula in the schedule:

• Weight = Length * Unit weight per linear (length)

For measurement of painting, create a material take-off schedule with the following fields:

Or base on a specially defined surface area parameter for the structural steel objects.

Note:

• According to HKSMM5, the mass of structural members is measured based on their overall lengths with no 

deduction for splay cuts or mitred ends, notches and holes, and no addition for mass of weld fillets, bolts, nuts, 

washers, rivets, rolling margins, galvanising or other protective coatings.

Adjust for the following as necessary:

• Nil.
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9.2 STEEL BEAMS

9.2.1 BASIC MODELLING APPROACHES

Based on the structural framing template, create a loadable family type for each type and cross-sectional size of steel 

beams, and place the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters includes cross-sectional size, cut length (beam 

length), unit weight per linear length, volume, etc.

 

Figure 9.2.1 – 3D View of Steel Beam

Figure 9.2.2 – Connection details of Steel Beam
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9.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Steel beam marks.

2. Cross-sectional sizes and unit weights per length.

3. Types and grades of materials.

4. Surface treatments and finishes.

5. Castellated/tapered/curved/cambered.

9.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of steel beams, create a schedule with the following fields:

Set the following formula in the schedule:

• Weight = Cut Length * Unit weight per linear (length)

For measurement of painting, create a material take-off schedule with the following fields:

Or base on a specially defined surface area parameter for the structural steel objects.

Note:

• According to HKSMM5, the mass of structural members is measured based on their overall lengths with no 

deduction for splay cuts or mitred ends, notches and holes, and no addition for mass of weld fillets, bolts, nuts, 

washers, rivets, rolling margins, galvanising or other protective coatings.

Adjust for the following as necessary:

• Nil.
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9.3 STEEL BRACINGS

9.3.1 BASIC MODELLING APPROACHES

Based on the structural framing template, create a loadable family type for each type and cross-sectional size of steel 

bracings, and place the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters includes cross-sectional size, cut length (beam 

length), unit weight per linear length, volume, etc.

 

 
 Figure 9.3.1 – 3D View of Steel Bracing
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9.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Steel bracing marks.

2. Types and grades of materials.

3. Surface treatments and finishes.

4. Cross-sectional sizes and unit weights per length.

5. Castellated/tapered/curved/cambered.

9.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of steel bracings, create a schedule with the following fields:

Set the following formula in the schedule:

• Weight = Cut Length * Unit weight per linear (length)

For measurement of painting, see example for steel beams.

Note:

• According to HKSMM5, the mass of structural members is measured based on their overall lengths with no 

deduction for splay cuts or mitred ends, notches and holes, and no addition for mass of weld fillets, bolts, nuts, 

washers, rivets, rolling margins, galvanising or other protective coatings.

Adjust for the following as necessary:

• Nil.
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9.4 CONNECTIONS TO FRAMED MEMBERS

9.4.1 BASIC MODELLING APPROACHES

Based on the structural connections template, create a loadable family type for each type and size of connection plates 

by sketching the profile of the steel plates/stiffeners or brackets etc., and place the individual object in the designed 

location.

The relevant information that can be extracted from the parameters includes connection type, length, width, thickness, 

volume, unit weight per volume, etc.

 

  

 

 
 Figure 9.4.1 – 3D View of Connection Detail
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9.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Connection marks.

2. Connection types.

3. Types and grades of materials.

4. Surface treatments and finishes.

9.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of connections to framed members, create a schedule with the following fields:

Set the following formula in the schedule:

• Weight = Volume * Weight per volume

Note:

• According to HKSMM5, the mass of structural members is measured based on their overall lengths with no 

deduction for splay cuts or mitred ends, notches and holes, and no addition for mass of weld fillets, bolts, nuts, 

washers, rivets, rolling margins, galvanising or other protective coatings.

Adjust for the following as necessary:

• Nil.



89BIM Measurement Information Requirements 

9.5 METAL PROFILED SHEET DECKING

9.5.1 BASIC MODELLING APPROACHES

Based on the structural floors template, create a system family type for each type and thickness of metal profiled sheet 

decking, and place the individual object in the designed location to the required boundary.

The relevant information that can be extracted from the parameters includes thickness, perimeter, area, etc.

 

 Figure 9.5.1 – 3D View of Metal Profiled Sheet Decking
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9.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Steel decking marks. (if any)

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Profiles and thicknesses of decking.

4. Horizontal/sloping/curved.

9.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of metal profiled sheet decking, create a schedule with the following fields:

Note:

• Add a field to enter the soffit heights from finished floor level below ≤ 5.00 m, and thereafter in 1.50 m stages, 

according to HKSMM5.

• According to HKSMM5, metal decking area is measured based on the finished area of concrete cast onto the 

decking.

• There is an alternative measurement rule of no deduction for voids ≤ 1.00 m2.

Adjust for the following as necessary:

• Nil.
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SECTION 10 – WATERPROOFING

10.1 WATERPROOFING

10.1.1 BASIC MODELLING APPROACHES

Waterproofing includes roofing, tanking and damp-proofing, and related work. There can be three modelling 

approaches for waterproofing as follows:

1) Create Rooms;

2) Apply Paint; or

3) Create separate layers by modelling Floor and Wall as waterproofing layers.

Refer to Section 20.1.1 for details of the modelling approaches.

1) Create Rooms:

Example of waterproofing modelled by Rooms:

 

 

 

 

H: Horizontal 
V: Ver�cal 

 
 Figure 10.1.1 – Plan View of Bathroom with Rooms
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2) Apply Paint:

Example of waterproofing by applying “Paint”:

 

 

Figure 10.1.2 – 3D View of Area Applying “Paint” 

for Waterproofing Layer
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3) Create separate layers by modelling Floor and Wall as waterproofing layers:

Example of waterproofing modelled by separate layers of walls and floors:

 

 

 
 Figure 10.1.3 – 3D View of Waterproofing on Walls
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 Figure 10.1.4 – 3D View of Waterproofing on Floors
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10.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Waterproofing marks. (if any)

2. Waterproofing types.

3. Kind and quality of waterproofing materials.

4. Thicknesses and number of coats or layers.

5. Horizontal/sloping (> 15° from horizontal)/vertical/curved.

Depending on the modelling approach, the model may not have included all the information as listed above.

10.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of waterproofing, create relevant material take-off schedules or schedules depending on the 

modelling approach.

1) Create Rooms:

For measurement of waterproofing by Rooms, create a schedule with the following fields (details referring to 

Section 20.1.3):

Example of Waterproofing Schedule – Horizontal by Rooms

Example of Waterproofing Schedule – Vertical by Rooms
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2) Apply Paint:

For measurement of waterproofing by applying “Paint” with split function, create a material take-off schedule to 

include “Material: Area” (details referring to Section 20.1.3):

Example of Waterproofing – Schedule by Applying Paint

3) Create separate layers by modelling Floor and Wall as waterproofing layers:

For measurement of waterproofing layers modelled by Floor and Wall, create material take-off schedules to include 

the following fields (details referring to Section 20.1.3):

Example of Waterproofing – Horizontal Schedule (created by “Floor”)
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Example of Waterproofing – Vertical Schedule (created by “Wall”)

Note:

• According to HKSMM5, waterproofing area is measured based on that in contact with base.

Adjust for the following as necessary:

• Doors and windows (for the approach adopting “Rooms”, the quantities given are based on the overall dimensions 

without deduction of openings).

• Voids and openings if required.

• Skirtings and turn-ups, curbs, channels, cesspools, sumps, etc.

• As required based on the SMM rule chosen.
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SECTION 11 – CURTAIN AND GLASS WALLING, CLADDING AND COVERINGS

11.1 CURTAIN WALLING

11.1.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type of curtain walls, and place the individual object 

in the designed location to the required alignment and top and base levels.

The relevant information that can be extracted from the parameters includes length, unconnected height (height), area, 

etc.

 

 

 
 Figure 11.1.1 – 3D View of Curtain Walling
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Length is determined by the profile setting.

Example 1 shows the profile cut at centre of mullion:
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Example 2 shows the profile at internal side of mullion:
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11.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Curtain wall marks.

2. Materials, qualities, construction, and surface finishes of framing members.

3. Types and thicknesses of vision and spandrel glass panels.

4. Mullion and transom spacings.

5. Vertical/horizontal/sloping (> 15º from horizontal)/curved.

6. Opening types – openable windows/glazed doors/louvres/protective bearers/others.

11.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of curtain walls, create a schedule with the following fields:

Note:

• According to HKSMM5, curtain walling area is measured based on its exposed faces.

Adjust for the following as necessary:

• Length, depending on whether the profile setting matches the method of measurement.
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11.2 GLASS WALLING

11.2.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family for each type of glass walls, and place the individual object in the 

designed location to the required alignment and top and base levels.

The relevant information that can be extracted from the parameters includes length, unconnected height (height), area, 

etc.

 

 Figure 11.2.1 3D View of Glass Walling
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11.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1 Glass wall marks.

2 Materials, qualities, construction and surface finishes of framing members.

3 Types and thicknesses of glass panels.

4 Mullion spacings. Typical heights of glass panels.

5 Vertical/horizontal/sloping (> 15º from horizontal)/curved.

6 Opening types – openable windows/glazed doors/louvres/protective bearers/others.

11.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of glass walls, create a schedule with the following fields:

Note:

• When creating the relevant schedule, while the family name “curtain wall” is still being used, the schedule title 

should be revised from “Curtain Wall Schedule” to “Glass Wall Schedule”.

• According to HKSMM5, glass walling area is measured based on its exposed faces.

Adjust for the following as necessary:

• Length, depending on whether the profile setting matches the method of measurement.
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11.3 WALL CLADDING

11.3.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type of wall cladding, and place the individual object 

in the designed location to the required alignment and top and base levels.

The relevant Information that can be extracted from the parameters includes length, unconnected height (height), area, 

etc.

 

 

 Figure 11.3.1 3D View of Wall Cladding
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11.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Wall cladding marks.

2. Materials, qualities, construction and surface finishes of claddings, and backings (if any).

3. Dimensional descriptions of claddings.

4. Vertical/horizontal/sloping (> 15º from horizontal)/curved.

5. Opening types – openable windows/glazed doors/louvres/protective bearers/others.

11.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of wall cladding, create a schedule with the following fields:

Note:

• When creating the relevant schedule, while the family name “curtain wall” is still being used, the schedule title 

should be revised from “Curtain Wall Schedule” to “Wall Cladding Schedule”.

• According to HKSMM5, wall cladding area is measured based on its exposed faces.

Adjust for the following as necessary:

• Length, depending on whether the profile setting matches the method of measurement.
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11.4 SKYLIGHTS

11.4.1 BASIC MODELLING APPROACHES

Based on the windows template, create a loadable family type for each type and bay size of skylights, and place the 

individual object in the designed location to the required area.

Adopt parametric modelling such that the model geometry will be changed accordingly when the dimensional values 

are modified. This can avoid inconsistency between geometrical and non-geometrical information.

The relevant information that can be extracted from the parameters includes number, length and width of skylight 

panels, overall length, width and area of skylight, etc.

 

 
 

 Figure 11. 4.1 – 3D View of Skylight

 
Figure 11.4.2 – Plan View of Skylight
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11.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Skylight marks.

2. Materials, qualities, construction and surface finishes of framing members.

3. Overall sizes.

4. Types and thicknesses of glass panels.

5. Structural glazing system.

6. Horizontal/sloping (> 15º from horizontal)/curved.

This sample model has not included:

a. Fixing details to host.

11.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of skylights, create a schedule with the following field:

Note:

• When creating the relevant schedule, while the family name “window” is still being used, the schedule title should 

be revised from “Window Schedule” to “Skylight Schedule”.

• According to HKSMM5, skylight area is measured based on its exposed faces.

Adjust for the following as necessary:

• Nil.
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11.5 GLAZED COVERED WALKWAYS

11.5.1 BASIC MODELLING APPROACHES

Based on one of the generic model templates, create a loadable family type for each type and size of covered 

walkways, and place the individual object in the designed location.

Adopt parametric modelling such that the model geometry will be changed accordingly when the dimensional values 

are modified. This can avoid inconsistency between geometrical and non-geometrical information.

The dimensions stated in the Type Name should be the overall dimensions of the object.

The relevant information that can be extracted from the parameters includes overall length and width, etc.

 

 
 Figure 11.5.1 – 3D View of Glazed Covered Walkway

Figure 11.5.2 – Plan View of Glazed Covered Walkway
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11.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Covered walkway marks.

2. Materials, qualities, construction and surface finishes of framing members.

3. Overall sizes.

4. Types and thicknesses of glass/polycarbonate panels; flat or curved.

5. Structural glazing system.

This sample model has not included:

a. Foundation details of supports.

11.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of glazed covered walkways, create a schedule with the following fields:

Note:

• According to HKSMM5, glazed covered walkway is measured along its centre line if measured by length. 

Otherwise, they are measured by numbers.

Adjust for the following as necessary:

• Nil.
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SECTION 12 – WINDOWS, LOUVRES AND SHOP FRONTS

12.1 WINDOWS

12.1.1 BASIC MODELLING APPROACHES

Based on the windows template, create a loadable family type for each type and size of windows, and place the 

individual object in the designed location.

The relevant information that can be extracted from the parameters includes width, height, sill height, etc.

 

 
 Figure 12.1.1 – 3D View of Window

 
 Figure 12.1.2 – Elevation View of Window



111BIM Measurement Information Requirements 

12.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Window marks.

2. Materials, qualities, construction and surface finishes of framing members.

3. Structural opening sizes.

4. Overall window sizes.

5. Types and thicknesses of glass panels.

6. Ironmongery.

7. Fire resistance rating.

12.1.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of windows, create a schedule with the following fields:

Note:

• Overall window size is used for describing the window.

• Structural opening size is used for measurements related to the opening size.

Adjust for the following as necessary:

• Nil.
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12.2 LOUVRES

12.2.1 BASIC MODELLING APPROACHES

Based on the windows template create a loadable family type for each type and size of louvres, and place the individual 

object in the designed location.

The relevant information that can be extracted from the parameters includes width, height, sill height, etc.

 

 
 Figure 12.2.1 – 3D View of Louvre (external side)

 
 Figure 12.2.2 – Elevation View of Louvre
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12.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Louvre marks.

2. Louvre types: weatherproof/fixed/adjustable.

3. Materials, qualities, construction and surface finishes of framing and blading members.

4. Structural opening sizes.

5. Overall louvre sizes.

6. Ironmongery.

7. Fire resistance rating.

12.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of louvres, create a schedule with the following fields:

Note:

• Overall louvre size is used for describing the louvre.

• Structural opening size is used for measurements related to the opening size.
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For measurement of paint/finishes around sides of openings, use paint tool:

Figure 12.2.3 – 3D View of Louvre (internal side)

Adjust for the following as necessary:
• Nil.
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12.3 SHOP FRONTS

12.3.1 BASIC MODELLING APPROACHES

Based on the curtain panels template, create a loadable family type for each type and height of shop front, and place 

the individual object in the designed location to the required length.

The relevant information that can be extracted from the parameters includes panel width, height, shopfront length, 

area, etc.

 
 Figure 12.3.1 – 3D View of Shop Front
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12.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Shop front marks.

2. Materials, qualities, construction and surface finishes of framing members.

3. Overall shopfront sizes.

4. Types and thicknesses of glass panels.

5. Any glazed doors or other openings.

6. Ironmongery.

7. Any sloping/curved surfaces.

12.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of shop fronts, create a schedule with the following fields:

Note:

• The descriptions of the quantities should be clear as to the meaning of the shop front heights when there are false 

ceilings and supporting frames above false ceilings.

Adjust for the following as necessary:

• Extra over shop fronts for glazed doors.

• Ironmongery for glazed doors if measured separately.
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SECTION 13 – DOORS, GATES, SHUTTERS AND IRONMONGERY

13.1 TIMBER DOORS

13.1.1 BASIC MODELLING APPROACHES

Based on the doors template, create a loadable family type for each type and size of timber doors, and place the 

individual object in the designed location.

The relevant information that can be extracted from the parameters includes structural opening width and height, door 

overall width and height, door panel width and height, sill height, etc.

 

 
 Figure 13.1.1 – Front Elevation of Timber Door
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Figure 13.1.2 – Door Details
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13.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Timber door marks.

2. Door types – single-leaf/double-leaf/swinging/sliding/folding.

3. Materials, qualities, construction, and surface finishes of doors.

4. Structural opening sizes.

5. Overall sizes.

6. Sizes and thicknesses of door panels.

7. Cross-sectional sizes of door frames/linings and architraves.

8. Glazed panels and louvres (if any) and their dimensions.

9. Wicket doors (if any) and their dimensions.

10. Fire resistance ratings and sound reduction ratings (if any).

11. Ironmongery or, if specially specified, ironmongery schedule and marks.

13.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of timber doors, create a schedule with the following fields:

Note:

• The descriptions of the quantities should be clear as to the meaning of the overall size.

Adjust for the following as necessary:

• Nil.
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13.2 METAL DOORS

13.2.1 BASIC MODELLING APPROACHES

Based on the doors template, create a loadable family type for each type and size of metal doors, and place the 

individual object in the designed location.

The relevant information that can be extracted from the parameters includes structural opening width and height, door 

and frame overall width and height, door panel width and height, sill height, etc.

 

 
 Figure 13–.2.1 - 3D View of Metal Door
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13.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Metal door marks.

2. Door types – single-leaf/double-leaf/ swinging/ sliding/folding.

3. Materials, qualities, construction and surface finishes of door and frames.

4. Overall size.

5. Sizes and thicknesses of door panels.

6. Cross-sectional sizes and thicknesses of door frames/linings and architraves.

7. Glazed panels and louvres (if any) and their dimensions.

8. Wicket doors (if any) and their dimensions.

9. Fire resistance ratings and sound reduction ratings (if any).

10. Ironmongery or, of specially specified, ironmongery schedule and ironmongery marks.

13.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of metal doors, create a schedule with the following fields:

Note:

• The descriptions of the quantities should be clear as to the meaning of the overall size.

Adjust for the following as necessary:

• Nil.
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13.3 GLAZED DOORS

13.3.1 BASIC MODELLING APPROACHES

Based on the doors template, create a loadable family type for each type and size of glazed doors, and place the 

individual object in the designed location.

The relevant information that can be extracted from the parameters includes structural opening width and height, door 

panel width and height, sill height, etc.

 

 Figure 13.3.1 – 3D View of Glazed Door
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Figure 13.3.2 – Elevation View of Glazed Door
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13.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Glazed door marks.

2. Door types – single-leaf/double-leaf/swinging/sliding/folding.

3. Materials, qualities, construction and surface finishes of doors.

4. Structural opening sizes.

5. Overall sizes.

6. Sizes and thicknesses of glass door panels.

7. Cross-sectional sizes and thicknesses of door frames/linings and architraves (if any).

8. Fire resistance ratings (if any).

9. Ironmongery or, if specially specified, ironmongery schedule and marks.

13.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of glazed doors, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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13.4 GATES

13.4.1 BASIC MODELLING APPROACHES

Based on the doors template, create a loadable family type for each type and size of gates, and place the individual 

object in the designed location.

The relevant information that can be extracted from the parameters includes structural opening width and height, gate 

and frame overall width and height, door panel width and height, sill height, etc.

 

 

 Figure 13.4.1 – 3D View of Grate
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Figure 13.4.2 – Elevation of Gate
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13.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Gate marks.

2. Gate types – single-leaf/double-leaf/swinging/sliding/folding.

3. Materials, qualities, construction and surface finishes of gates and frames.

4. Structural opening sizes.

5. Overall sizes.

6. Sizes and thicknesses of gate panels.

7. Cross-sectional sizes and thicknesses of sliding tracks and frames.

8. Glazed panels and louvres (if any) and their dimensions.

9. Wicket doors (if any) and their dimensions.

10. Manually operated or electrically operated.

11. Fire resistance ratings and sound reduction ratings (if any).

12. Ironmongery or, if specially specified, ironmongery schedule and marks.

13.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of gates, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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13.5 ROLLING SHUTTERS

13.5.1 BASIC MODELLING APPROACHES

Based on the specialty equipment template, create a loadable family type for each type and size of rolling shutters, and 

place the individual object in the designed location.

The relevant information that can be extracted from the parameters includes clear opening width and height, shutter, 

frame and hood overall width and height, etc.

 

 Figure 13.5.1 – 3D View of Rolling Shutter
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Figure 13.5.2 – Elevation of Rolling Shutter
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13.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Rolling shutter marks.

2. Shutter types.

3. Materials, qualities, construction and surface finishes of shutters, frames and hoods..

4. Clear opening sizes.

5. Shutter, frame and hood overall sizes.

6. Cross-sectional sizes and thicknesses of shutters, frames and hoods.

7. Access/pass doors (if any) and their dimensions.

8. Horizontal or vertical.

9. Manually operated or electrically operated.

10. Fire resistance ratings (if any).

11. Ironmongery or, if specially specified, ironmongery schedule and marks.

13.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of rolling shutters, create a schedule with the following fields:

Note:

• The descriptions of the quantities should be clear as to the meaning of the overall size.

Adjust for the following as necessary:

• Nil.
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13.6 IRONMONGERY

13.6.1 BASIC MODELLING APPROACHES

Based on one of the generic model templates, create a loadable family type for each type and size of ironmongery, and 

place the individual object in the designed location.

The relevant information that can be extracted from the parameters includes size, etc.

 
 Figure 13.6.1 – 3D View of Handle

 

 Figure 13.6.2 – Plan View of Handle
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13.6.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Ironmongery marks.

2. Materials, qualities and surface finishes of ironmongery.

3. Sizes.

4. Brands and model numbers (if available).

5. Fixing backgrounds: timber/metal/glass/others (including door marks).

13.6.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of ironmongery, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 14 – PARTITIONS

14.1 SLIDING AND FOLDING PARTITIONS

14.1.1 BASIC MODELLING APPROACHES

Based on one of the generic model templates, create a loadable family type for each type and size of sliding and 

folding partitions, and place the individual object in the designed location.

Adopt parametric modelling such that the model geometry will be changed accordingly when the dimensional values 

are modified. This can avoid inconsistency between geometrical and non-geometrical information.

The relevant information that can be extracted from the parameters includes length (clear width of opening to fill up), 

height (up to false ceiling or structural ceiling), panel number, etc.

 

 

 Figure 14.1.1 – 3D View of Sliding and Folding Partitions
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14.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Sliding and folding partition marks (or location identifications).

2. Materials, qualities, construction and surface finishes of panels.

3. Overall sizes.

4. Overall height including open framing or unfinished partitioning above ceilings.

5. Access doors and pocket enclosures (if any) and their dimensions.

6. Required suspension systems, guide rails, floor guides and other accessories and fixings.

7. Manually operated or electrically operated.

8. Fire resistance ratings and sound reduction ratings.

14.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of sliding and folding partitions, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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14.2 TOILET AND SHOWER CUBICLE PARTITIONS

14.2.1 BASIC MODELLING APPROACHES

Based on the specialty equipment template, create a loadable family type for each type and size of toilet and shower 

cubicles, and place the object in the designed location.

Adopt parametric modelling such that the model geometry will be changed accordingly when the dimensional values 

are modified. This can avoid inconsistency between geometrical and non-geometrical information.

The relevant information that can be extracted from the parameters includes overall size, number of bays, etc.

 

 

 
 Figure 14.2.1 – 3D View of Toilet and Shower Cubicles

 
Figure 14.2.2 – Plan and Elevation View of Toilet and Shower Cubicles
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14.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Toilet/shower cubicle marks (or location identifications).

2. Cubicle partitions or back wall panels type.

3. Materials, qualities, heights, thicknesses and surface finishes of cubicle partitions or back wall panels and doors.

4. Overall sizes.

5. Number of bays in cubicles or access panels in back wall panels.

6. Whether recessed/corner units.

7. Required accessories like indicator locks, knobs, hinges, coat hooks, door stoppers, toilet roller holders, trays and 

other fixings.

14.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of toilet and shower cubicles, create a schedule with the following fields:

Note:

• The descriptions of the quantities should be clear as to the meaning of the overall size.

Adjust for the following as necessary:

• Nil.
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SECTION 15 – RAISED ACCESS FLOORS

15.1 RAISED ACCESS FLOORS

15.1.1 BASIC MODELLING APPROACHES

Based on the floors template, create a system family type for each type and height of raised access floor, and place 

the individual object in the designed location to the required boundary.

The relevant information that can be extracted from the parameters includes raised height, perimeter, area, etc.

 

Figure 15.1.1 – 3D View of Raised access floors

Figure 15.1.2 – Elevation View of Raised access floors
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15.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Raised access floor marks.

2. Materials, qualities and construction of raised access floors.

3. Thicknesses and modular sizes of panels.

4. Cover/top finishes of panels.

5. Heights of cavities from the top surfaces of subfloors to the underside of panels.

15.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of raised access floors, create a schedule with the following fields:

Note:

• According to HKSMM5, raised access floor area is measured net based on its exposed faces.

• There is an alternative measurement rule of no deduction for voids ≤ 1.00 m2.

Adjust for the following as necessary:

• Nil.
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SECTION 16 – HANDRAILS, BALUSTRADES, LADDERS AND STAIRS

16.1 HANDRAILS

16.1.1 BASIC MODELLING APPROACHES

Staircase handrail is automatically generated when a stair is created or it can be placed on existing stair object.

Based on the railings template, create a system family type for each type and cross-sectional size of staircase 

handrails, and place the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameter includes length (the total length includes both end 

extensions is required), height, etc.

 
 Figure 16.1.1 – 3D View of Handrail and Stair

 

1710.3 

1710.3 

1425.2 

Figure 16.1.2 – Section of Handrail and Stair
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The top and bottom end extensions of 300 mm are set by clicking Top Rail: Type box in the Railing Type Property pallet 

to go to the Top Rail Type Property pallet, and defining as follows:

The “Plus Tread Depth” is also clicked so that the sloping part of the handrail is extended by one more tread depth to 

meet the design.

16.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Staircase handrail marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Railing height and cross-sectional sizes of members.

4. Straight/curved.

5. Secondary handrails (if any).

6. Removable/openable portions (in any) including associated ironmongery.

7. Tactile indicators (if any).
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16.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of staircase handrails, create a schedule with the following fields:

Note:

• When creating the relevant schedule, while the family name “railing” is still being used, the schedule title should be 

revised from “Railing Schedule” to “Staircase Handrail Schedule”.

Set the following formula in the schedule:

• Total Length = Measured Length (of rail) + Extended length at both ends.

Note:

• When modelling staircase handrail using the above settings, the reported “Length” of the railing or handrail is 

based on the sloping length of the stair from the lowest riser to the highest riser only (1425 mm as shown above), 

excluding the lengths of the end extensions and the sloping length due to one more tread depth.

• The “Measured length” of 1710.3 mm is the sloping length measured and entered manually.

• The “Extended length at both ends” is set as a constant.

• The “Measured Length” can in fact be calculated by “Length/No. of treads x (No. of treads + 1)” (i.e. 1,425.2 / 5 x 6) 

= 1710.24 mm and called “Sloping Length”.

• If the staircase handrail length is adjusted by clicking the handrail modelled then clicking Modify > Edit Path, then 

the reported “Length” will be adjusted accordingly but still excluding the above. If the lengths of the end extensions 

are set to 0 and the one more tread depth is disabled, then the “Length” will be the correct total length.

Adjust for the following as necessary:

• Nil.
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16.2 BALUSTRADES

16.2.1 BASIC MODELLING APPROACHES

Based on the railings template, create a system family type for each type and height of balustrades, and place the 

individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters includes length, height, etc.

 Figure 16.2.1 – 3D View of Balustrade

Figure 16.2.2 – Section of Balustrade



143BIM Measurement Information Requirements 

16.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Balustrade marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Balustrade height and cross-sectional sizes of members.

4. Straight/curved.

5. Secondary handrails (if any).

6. Removable/openable portions (in any) including associated ironmongery.

7. Tactile indicators (if any).

16.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of balustrades, create a schedule with the following fields:

Note:

• The effect of the lengths of the end extensions as described for staircase handrails still apply here because they all 

use the same Railing family.

Adjust for the following as necessary:

• Nil.



144 BIM Measurement Information Requirements 

16.3 CAT LADDERS

16.3.1 BASIC MODELLING APPROACHES

Based on the specialty equipment template, create a loadable family type for each type and height of cat ladders, and 

place the individual object in the designed location.

The relevant information that can be extracted from the parameters includes dimensions of fabrication of component 

members, height etc.

 
 Figure 16.3.1 – 3D View of Cat Ladder

Figure 16.3.2 – Plan View of Cat Ladder
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16.3.1 BASIC MODELLING APPROACHES

Figure 16.3.3 – Elevation of Cat Ladder
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16.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Cat ladder marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Widths and heights of cat ladders.

4. Sizes of members.

5. Any openable gates, hoop guards, lockable access doors, and rest platforms, with details.

16.3.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of cat ladders, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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16.4 STAIRS

16.4.1 BASIC MODELLING APPROACHES

Based on the stairs template, create a system family type for each type and size of assembled stairs, and place the 

individual object in the designed location to the required length and top and base levels.

The relevant information that can be extracted from the parameters includes actual number of risers, actual riser height, 

actual tread depth, etc.

 
 Figure 16.4.1 – 3D View of Metal Stair

  
 Figure 16.4.2 – Plan View of Metal Stair Figure 16.4.3 – Section View of Metal Stair
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16.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Metal stair marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Sizes of stairs and members.

4. Numbers of flights between landings and floors.

5. Fire resistance coatings (if required).

16.4.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of metal stairs, create a schedule with the following fields:

Note:

• According to HKSMM5, handrails and balustrades are measured separately from stairs unless otherwise stated.

Adjust for the following as necessary:

• Nil.
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16.5 SUSPENDED WALKWAYS

16.5.1 BASIC MODELLING APPROACHES

Based on the railings template, create a loadable family type for each type and cross-sectional size of suspended 

walkways, and place the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters includes walkway length, width, height, etc.

 
 Figure 16.5.1 – 3D View of Suspended Walkway

Figure 16.5.2 – Elevation of Suspended Walkway
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16.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Walkway marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Widths of walkways and height of railings.

4. Sizes of members.

5. Fire resistance coatings (if required).

16.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of suspended walkways, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 17 – METALWORK

17.1 SKIRTINGS

17.1.1 BASIC MODELLING APPROACHES

Based on the walls template, create a system family type for each type and cross-sectional size of skirtings, and place 

the individual object in the designed location to the required alignment and length.

The relevant Information that can be extracted from the parameters includes length, unconnected height (skirting 

height), width (thickness), etc.

 

Figure 17.1.1 – 3D View of Metal Skirtings

Figure 17.1.2 – Detail of Metal Skirtings
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17.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Skirting marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Overall heights and thicknesses of skirtings.

4. Straight/curved.

17.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of skirtings, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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17.2 GRATINGS AND FRAMES TO FLOOR CHANNELS

17.2.1 BASIC MODELLING APPROACHES

Based on the generic models template, create a loadable family type for each type and cross-sectional size of gratings, 

and place the individual object in the designed location to the required alignment and length.

 
 Figure 17.2.1 – 3D View of Gratings
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17.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Grating marks (or locational references).

2. Materials, qualities, construction, surface finishes of gratings and support channels.

3. Cross-sectional sizes and typical lengths of gratings. Sizes of slots/holes and spacings.

4. Cross-sectional sizes of support channels.

5. Straight/curved.

17.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of gratings and frames, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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17.3 STEP IRONS

17.3.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of step irons, and place 

the individual object in the designed location.

 
 Figure 17.3.1 – 3D View of Step Irons

 
 Figure 17.3.2 – Plan View of Step Iron Figure 17.3.3 – Front Elevation of Step Irons
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17.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Step iron marks (or locational references).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Overall sizes and thicknesses.

17.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of step irons, create a schedule with the following fields:

Note:

• Step irons are only measured independently where they are not specified and included as part of another object of 

other section, e.g., manhole.

• With sufficient reference marks and location reference, the number of step irons in individual locations can be 

extracted; or designers/modellers provide a schedule on the same.

Adjust for the following as necessary:

• Nil.
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17.4 MANHOLE COVERS AND FRAMES

17.4.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of manhole covers, and 

place the individual object in the designed location.

 
 Figure 17.4.1 – 3D View of Manhole Cover
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17.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Manhole cover marks (or locational references).

2. Manhole cover types: light duty/medium duty/heavy duty/single seal/double seal/recessed pattern/finished to 

match surrounding.

3. Materials, qualities, construction, surface finishes of manhole covers and frames.

4. Clear opening sizes.

17.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of manhole covers, create a schedule with the following fields:

Note:

• Manhole covers and frames are only measured independently where they are not specified and included as part of 

another object of other section, e.g., manhole.

Adjust for the following as necessary:

• Nil.
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17.5 HINGED COVERS AND FRAMES

17.5.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of hinged covers, and 

place the individual object in the designed location.

 

Figure 17.5.1 – 3D View of Hinged Cover

Figure 17.5.2 – Plan View of Hinged Cover 
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17.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Hinged cover marks (or locational references).

2. Materials, qualities, construction and surface finishes of hinged covers and frames.

3. Clear opening sizes.

4. Ironmongery like hinges, lock plates and padlocks (if any).

17.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of hinged covers, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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17.6 DRYING RACKS

17.6.1 BASIC MODELLING APPROACHES

Based on one of the generic model templates, create a loadable family type for each type and size of drying racks, and 

place the individual object in the designed location.

 

 Figure 17.6.1 – 3D View of Drying Rack

Figure 17.6.2 – Plan View of Drying Rack
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17.6.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Drying rack marks.

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Overall sizes.

4. Canvas covers (if any).

17.6.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of drying racks, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 18 – JOINERY

18.1 WOOD FLOORING

18.1.1 BASIC MODELLING APPROACHES

Based on the architectural floors template, create a system family type for each type and thickness of wood flooring, 

place the individual object in the designed location to the required boundary. Set the height offset from base level equal 

to the overall thickness of floor finishes.

The relevant information that can be extracted from the parameters includes thickness, perimeter, area, etc.

 

Figure 18.1.1 – 3D View of Wood Flooring

Figure 18.1.2 – Details of Wood Flooring
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18.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Flooring marks (or locational references).

2. Materials, qualities, and surface finishes.

3. Typical sizes and thicknesses, pattens and top layers.

4. Moisture resisting membranes, underlays, sub-bases, batten systems or and sub-floor systems.

5. Methods of jointing and bedding materials.

18.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of wood floorings, create a schedule with the following fields:

Note:

• According to HKSMM5, wood flooring area is measured based on the net area covered.

• There is an alternative measurement rule of no deduction for voids ≤ 1.00 m2.

Adjust for the following as necessary:

• Nil.
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18.2 WOOD FALSE CEILINGS AND BULKHEADS

18.2.1 BASIC MODELLING APPROACHES

Based on the architectural walls template, create a system family type for each type and cross-sectional size of 

bulkheads to ceilings, and place the individual object in the designed location to the required alignment and length.

Based on the ceilings template, create a system family type for each type and thickness of compound ceilings, and 

place the individual object in the designed location to the required boundary.

The relevant information that can be extracted from the parameters includes length, unconnected height (bulkhead 

height), width (bulkhead thickness), area, etc.
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Figure 18.2.1 – 3D View of Bulkheads to ceiling

Figure 18.2.2 – Section of Bulkheads to ceiling
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18.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Location reference (fix to walls and columns, ceilings and sides and soffits of beams, pipe and service ducts or 

other).

2. Materials, qualities, construction, surface finishes and fixing methods.

3. Thicknesses and typical sizes of facing panels.

4. Sizes and spacings of members of supporting frames.

5. Horizontal/(sloping > 15° from horizontal)/vertical/curved.

18.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of bulkheads, create wall and ceiling schedules with the following fields:

Note:

• According to HKSMM5, wood false ceiling and bulkhead areas are measured based on the net area covered.

• There is an alternative measurement rule of no deduction for voids ≤ 1.00 m2.

Adjust for the following as necessary:

• Nil.



168 BIM Measurement Information Requirements 

SECTION 19 – FURNITURE, FITTINGS AND EQUIPMENT

19.1 FURNITURE

19.1.1 BASIC MODELLING APPROACHES

Based on the furniture template, create a loadable family type for each type and size of furniture, and place the 

individual object in the designed location.

The relevant information that can be extracted from the parameters includes size, etc.

 

 Figure 19.1.1 – 3D View of Fixtures and Furnishings
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19.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Furniture marks.

2. Materials, qualities, construction and surface finishes.

3. Overall sizes.

4. Manufacturers’ reference marks (if any).

19.1.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of furniture, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 20 – SURFACE FINISHES

20.1 FLOOR, WALL AND CEILING FINISHES

20.1.1 BASIC MODELLING APPROACHES

(A) Internal Finishes

Internal finishes include plastering, stone, tiling, painting, etc. There can be three modelling approaches for internal 

finishes as follows:

1) Create Rooms;

2) Apply Paint; or

3) Create separate layers by modelling Floor and Wall as internal finishes layers.

A1 Create Rooms:

Based on the room template, tag each room bounded by room-bounding elements, including walls, columns, 

floors, roofs, ceilings, curtain systems, etc. Where no room-bounding elements exist, add room separation lines.

When a tagged room is highlighted, the properties pallet will show the room perimeter, area and volume.

 

 
 

 Figure 20.1.1 – Properties of Rooms 

Figure 20.1.2 – Plan View of model (assigned Room)
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A2 Apply Paint:

Create a material parameter by applying a Material to the face of an object with the “Paint” function. The whole 

surface of the selected face of the object or family will be painted. For applying different materials to the same 

surface, use the “Split” function to divide the surface into different regions. The finishing areas with Paint applied 

can only be extracted using the material take-off schedule.

Select appropriate 
material

Figure 20.1.3 – Select Material for “Paint”
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Figure 20.1.4 – 3D View of Finishing Works with Paint Applied

A3 Create separate layers by modelling Floor and Wall as internal finishes layers:

Create an additional layer of floor and/or wall on the designed surfaces to the required boundary to serve as 

finishes layer.

The relevant information that can be extracted from the parameters includes length, height, perimeter, area, etc.
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 Figure 20.1.5 – Properties of Wall Finishes Figure 20.1.6 – 3D View of Bathroom modelled 

  with Wall Finishes

(B) External Finishes

External finishes include plastering, stone, tiling, painting, etc. There can be two modelling approaches for external 

finishes as follows:

1) Apply Paint; or

2) Create separate layers by modelling Floor and Wall as external finishes layers.

The steps described in 20.1.1(A) above can be followed for these two approaches.
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20.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

(A) In-situ finishes (e.g., screeds, granolithic, terrazzo, plaster, mix-applied coatings, excluding those types of 

finishes stated in (B) & (C) below):

1. Finishes type/mark.

2. Compositions and mixes of materials.

3. Thicknesses, numbers of coats and surface finishes.

4. Works laid in complicated colours and/or patterns.

5. Admixtures including bonding agents, waterproofing agents, air entraining agents and the like.

6. Surface dressings including carborundum grains, stone chippings and the like.

7. Sealers including waterproofers, hardeners, dust-proofers and the like.

8. Whether laid monolithically in one operation with concrete base.

9. Methods of bedding/fixing and supporting frames (if any).

10. Fire resistance ratings/sound reduction ratings (if required).

(B) Tile-like finishes (Stone facing, tiling, rubber/plastic sheet, carpet, etc.):

1. Finishes type/mark.

2. Thicknesses, sizes and shapes of units.

3. Methods of bedding/fixing and jointing.

4. Admixtures including bonding agents, waterproofing agents and the like. (if required)

5. Surface treatments including wax polishing, sealing coats and the like. (if required)

6. Horizontal/sloping (>15o from horizontal)/curved work.

7. Works laid in complicated colours and/or patterns.

(C) Painting:

1. Finishes type/mark.

2. Types and numbers of priming or sealing coats.

3. Types and numbers of undercoats and finishing coats.
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20.1.3 QUANTITY TAKE-OFF GUIDELINES

(A) Create Rooms:

For measurement of finishes by Room tags, create schedules with the following fields:

Example of Room Schedule for Floor Finishes

Example of Room Schedule for Wall Finishes

Set the following formula in the schedule:

• Wall Area = Perimeter x Unbounded Height

Note:

• “Area” is for floor and ceiling finishes. It is the overall bounded area without deduction of any void and opening. 

Deduct voids and openings.

• Add sides of beams with finishes to ceiling areas.

• “Perimeter” is for skirting. Deduct lengths at openings.

• Check that the “Unbounded Height” represents the designed wall finish height, otherwise adjust.

• Deduct wall areas occupied by skirtings.

• Deduct openings, wants and ends of beams within the wall areas lower than the Unbounded Height.

• Adjust areas to sides and soffits of perimeter beams sitting over walls to either wall or ceiling finishes as designed.
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(B) Apply Paint:

For measurement of finishes by applying Paint, create a material take-off schedule with the following fields:

Example of Material Take-off Schedule for Painting for Floor Finishes

Example of Material Take-off Schedule for Painting for Wall Finishes

Note:

• The areas should be net of unfinished areas already.
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(C) Create separate layers by modelling Floor and Wall as internal/external finishing layers:

For measurement of finishes modelled by Floor and/or Wall, create relevant schedules with the following fields:

Example of Floor Tile Schedule

Example of Wall Tile Schedule

Set the following formula in the schedule:

• Wall Area = Perimeter x Unbounded Height

Note:

• The areas should be net areas of the layers.

• Refer to (A) for any similar issues for necessary adjustments.

Adjust for the following as necessary:

• Doors, windows and beams (for modelling approach adopting Room tags).

• Voids and openings if required.

• Overlaps of skirting and wall areas.

• Steps, curbs and channels.

• Beware that the measurement should be based on the “net area to be covered (i.e., the net background)”, while 

the models may give the areas along the centre line or the front face.



178 BIM Measurement Information Requirements 

20.2 ROOF TILE FINISHES

20.2.1 BASIC MODELLING APPROACHES

here can be two modelling approaches for roof tile finishes as follows:

1) Apply Paint; or

2) Create a relevant layer by floor as roof tile finishes.

See Section 20.1.1(A).

Example of roof tile modelled by a separate layer of floor:

 

 

 Figure 20.2.1 – Properties of Roof Tile

 Figure 20.2.2 – 3D View of Roof Tile
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20.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Finish marks.

2. Types, thicknesses, sizes and shapes of tiles.

3. Method of fixing including any batten systems.

4. Horizontal/sloping (> 15° from horizontal)/vertical/curved.

5. Work laid in complicated colours and/or patterns.

20.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of roof tile finishes, create a relevant material take-off schedule depending on the modelling 

approaches.

(A) Apply Paint:

For measurement of roof tile finishes by applying Paint, create a material take-off schedule with the following fields:

Example of Roof Tile Material Take-off Schedule (created by “Paint”)

(B) Create separate layers by modelling Floor as roof file layers:

For measurement of roof tile finishes modelled by Floor, create a schedule with the following fields:

Example of Roof Tile Schedule (created by “Floor”)

Adjust for the following as necessary:

• Voids and openings if required.

• Beware that the measurement should be based on the “net area to be covered (i.e., the net background)”.
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20.3 TACTILE

20.3.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of tactile, and place the 

individual object in the designed location.

Create shared parameters “Tactile Length” and “Tactile Width”, otherwise only volume is given.

The relevant information that can be extracted from the parameters includes tactile type, size, etc.

Another option for modelling tactile is to create a separate layer by Floor. Refer to Section 20.1.1(A).

 

 Figure 20.3.1 – Properties and 

 Figure 20.3.2 – 3D View of Tactile

 Type Properties of Tactile

Figure 20.3.3 – Plan View of Tactile
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20.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Tactile marks.

2. Tactile types: warning (or stop)/direction (or go)/turning (or positional).

3. Materials, qualities, surface finishes and fixing methods.

4. Sizes.

20.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of tactiles, create a schedule with the following fields:

Set the following formula in the schedule:

• Tile Area = Tile Length * Tile Width

Adjust for the following as necessary:

• Nil.
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SECTION 21 – PAINTING

21.1 PAINTING

21.1.1 BASIC MODELLING APPROACHES

The model information requirements for painting are similar to those for other types of finishes. Similarly, the approach 

to extracting quantities of painting is the same as that for finishes.

The basic modelling approaches, the information requirements for quantity take-off, and the quantity take-off guidelines 

are not repeated here.
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SECTION 22 – GLAZING

22.1 MIRRORS

22.1.1 BASIC MODELLING APPROACHES

Based on the furniture template, create a loadable family type for each type and size of mirrors, and place the individual 

object in the designed location.

The relevant information that can be extracted from the parameters includes width, height, etc.

  

  Figure 22.1.1 – 3D View of Mirror

Figure 22.1.2 – Front Elevation of Mirror
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22.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Mirror marks (or locational references).

2. Type, quality, overall sizes of mirrors. Thicknesses of glass.

3. Any bevelled edges, backings and edge frames.

4. Framing support details.

22.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of mirrors, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 23 – DRAINAGE BELOW GROUND

23.1 MANHOLES

23.1.1 BASIC MODELLING APPROACHES

Based on the generic model templates, create a loadable family type for each type and size of manholes, and place the 

individual object in the designed location.

Adopt parametric modelling such that the model geometry will be changed accordingly when the dimensional values 

are modified. This can avoid inconsistency between geometrical and non-geometrical information.

The relevant information that can be extracted from the parameters includes system type, manhole type, cover level, 

invert level, internal length/width, depth to invert, etc.

 

 Figure 23.1.1 – 3D View of Manhole
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 Figure 23.1.2 – DSD Standard Drawing DS 1004C

 Note: D is the diameter of pipe.

 For this example, D = 375mm.
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Figure 23.1.3 – Section
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23.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Manhole marks.

2. System types.

3. Manhole types.

4. Construction details of base slabs, walls and cover slabs.

5. Internal finishes.

6. Internal sizes.

7. Cover levels.

8. Invert levels of manholes.

9. Sizes of main and branch channels.

10. Manhole covers and frames

11. Accessories like backdrops, step irons, access ladders, etc. (if any)

23.1.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of manholes, create a schedule with the following fields:

Measurement of similar items such as drain pits, gullies, sump pits, grease traps, and petrol interceptor can be done 

by creating similar schedules.

Note:

• According to HKSMM5, manholes are to be classified by depth ≤ 1.00 m, and thereafter in 0.50 m stages. The 

depth is measured between the cover level and the invert level.

Adjust for the following as necessary:

• Nil.
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23.2 DRAIN PIPES

23.2.1 BASIC MODELLING APPROACHES

Based on the pipes template, create a system family type for each type of drain pipes with routing preferences set for 

different diameters and fittings, and place the individual object in the designed location to the required alignment and 

length.

The relevant information that can be extracted from the parameters includes system type, pipe type, size, length, etc.

 Figure 23.2.1 – 3D View of Drain Pipe

Start and End Offset should align with the manholes schedule.

However, Revit defaults the pipe level (the vertical justification) at the centre line of the pipe, while the invert level is the 

level of the internal bottom of a pipe. Therefore, half of the internal diameter should be deducted from the default pipe 

level to give the invert level. For the above example, the start level of FMH1.1 (i.e., the start end) at 101407.5 should 

minus half of the internal pipe diameter of 187.5 (= 375/2) to give the adjusted start invert level of 101220. For the 

other end at FMH1.2, the adjusted end invert level is 101300.
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23.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Pipe types: cast iron/vitrified clay/precast concrete/ductile iron/polyvinyl chloride/concrete porous/unglazed 

clayware/perforated plastic/other pipes.

3. Bedding type: bed/bed and haunch/bed and surround (for pipes in soil only).

4. Wrappings or linings to pipes (if any).

5. Painting to pipe (not for pipes in soil).

6. Pipe accessories.

7. Connecting to which manholes.

8. Methods of jointing.

9. Nominal diameters of drain pipes.

10. Bedding dimensions.

11. Commencement levels for drain pipe excavation (for pipes in soil only).

12. Invert levels of drain pipes at both ends.

23.2.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of drain pipes, create a schedule with the following fields:

Note:

• According to HKSMM5, pipes are measured along the centre lines of pipes over all bends, junctions and other pipe 

fittings, which are not separately measured.

• There is an alternative rule that all pipe fittings are enumerated, and pipes are still measured along the centre lines 

of pipes but not through pipe fittings.

• There is another alternative rule in HKSMM5 that drain pipes laid to or fixed to different backgrounds are not 

measured separately, but are grouped together.

• The alternative rules apply only if expressly so stated.

Adjust for the following as necessary:

• According to HKSMM5, the length of pipes entering manholes are measured to the inside surfaces of manholes. A 

special preamble is required for measuring drain pipes up to the external walls of manholes if this is the modelling 

practice of the project.
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SECTION 24 – WATER SUPPLY SYSTEMS AND DISPOSAL SYSTEMS

24.1 SANITARY FITTINGS AND ANCILLARIES

24.1.1 BASIC MODELLING APPROACHES

Based on the plumbing fixtures template, create a loadable family type for each type and size of sanitary fittings, and 

place the individual object in the designed location.

  

 Figure 24.1.1 – 3D View of Sanitary Fittings

24.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Sanitary fitting marks.

2. Types, materials, sizes, surface finishes and capacities.

3. Specification references.
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24.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of sanitary fittings, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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24.2 EQUIPMENT

24.2.1 BASIC MODELLING APPROACHES

Based on the plumbing fixtures template, create a loadable family type for each type and size of equipment, and place 

the individual object in the designed location.

 

Figure 24.2.1 – 3D View of Gas Water Heater

Figure 24.2.2 – Front Elevation of Gas Water Heater
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24.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. Equipment marks.

2. Types, sizes, surface finishes and capacities of equipment.

3. Specification references.

4. Fixing methods including any backings and supports.

5. Thermal insulations to equipment (if any).

6. Sound insulations to equipment (if any).

24.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of equipment, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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24.3 WATER SUPPLY PIPEWORK

24.3.1 BASIC MODELLING APPROACHES

Based on the pipes template, create a system family type for each type of pipes with routing set for different diameters 

and fittings, and place the individual object to the required alignment and length.

The relevant information that can be extracted from the parameters includes system type, pipe type, material, size, 

length, etc.

 Figure 24.3.1 – 3D View of Pipework

24.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Types, materials and nominal diameters of pipes.

3. Wrappings or insulations to pipes (if any).

4. Painting to pipes (if any).
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24.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of pipes, create a schedule with the following fields, sorted by system type, pipe type & size, and 

summed up by groups:

Figure 24.3.2 – 3D View of Pipework
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Also, a detailed schedule without summing up can also be created:

*The above image only shows part of the schedule.

Note:

• As an alternative rule in HKSMM5, pipework fixed to different backgrounds is not measured separately, and can be 

grouped together.

For pipework diameter > 110 mm

• The HKSMM5 stipulates that pipework is measured along the centre lines of pipes over all bends, junctions and 

other pipe fittings. Pipe fittings > 110 mm nominal diameter are enumerated as extra over pipework.

• There is an alternative rule in HKSMM5 that all pipe fittings > 110 mm nominal diameter are enumerated (instead 

of as extra over) for water supply systems, and pipework is measured along the centre lines of pipes only (i.e. not 

measured through pipe fittings).

For pipework diameter < = 110 mm

• For projects with full BIM information for pipework and fittings, the pipe lengths generated by Revit are the net 

lengths with gaps at fittings while HKSMM5 measures the pipe lengths through the fittings without deducting the 

gaps. Therefore, the Revit quantities for pipework < = 110 mm nominal diameter have to be adjusted to suit (e.g. 

adding the length of gaps x number of fittings by type).

• As an alternative, for measurement of pipework of size < = 110 mm nominal diameter, a special preamble should 

be given to measuring pipework along the centre lines of pipes only (i.e. not measured through pipe fittings), and all 

pipe fittings are enumerated.

Adjust for the following as necessary:

• See Note of 24.3.3 above.
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24.4 ABOVE GROUND DRAINS

24.4.1 BASIC MODELLING APPROACHES

Based on the pipes template, create a system family type for each type of pipes with routing set for different diameters 

and fittings, and place the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters includes system type, pipe type, material, size, 

length, etc.

 Figure 24.4.1 – 3D View of Drain Pipework

24.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Types, materials and nominal diameters of drainpipes.

3. Painting to drainpipes (if any).
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24.4.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of drainpipes, create a schedule with the following fields, sorted by system type, type & size, and 

summed up by groups:

Figure 24.4.2 – 3D View of Drain Pipework
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Also, a detailed schedule without summing up can also be created:

* The above image only shown part of the schedule

It should be noted that:

• As an alternative rule in HKSMM5, drainpipe fixed to different backgrounds is not measured separately, and all pipe 

fittings are enumerated.

• Lengths of pipes are the actual inclined length, not the horizontal length (as measured on plan).

For pipework diameter > 110 mm

• The HKSMM5 stipulates that the drainpipe is measured along the centre lines of pipes over all bends, junctions and 

other pipe fittings. Pipe fittings > 110 mm nominal diameter are enumerated as extra over pipework.

• There is an alternative rule in HKSMM5 that for above ground disposal systems all pipe fittings > 110 mm nominal 

diameter are enumerated (instead of as extra over), and drainpipe is measured along the centre lines of pipes only 

(i.e. not measured through pipe fittings).

For pipework diameter < = 110 mm

• For projects with full BIM information for pipework and fittings, the pipe lengths generated by Revit are the net 

lengths with gaps at fittings while HKSMM5 measures the pipe lengths through the fittings without deducting the 

gaps. Therefore, the Revit quantities for pipework < = 110 mm nominal diameter have to be adjusted to suit (e.g. 

adding the length of gaps x number of fittings by type).

• As an alternative, for measurement of pipework of size < = 110 mm nominal diameter, a special preamble should 

be given to measuring pipework along the centre lines of pipes only (i.e. not measured through pipe fittings), and all 

pipe fittings are enumerated.

Adjust for the following as necessary:

• See Note of 24.4.3 above.
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24.5 PIPE FITTINGS

24.5.1 BASIC MODELLING APPROACHES

Based on the pipe fittings template, create a loadable family type for each type and size of pipe fittings to be placed 

automatically when joining two pipes or turning a pipe, or placed manually in the designed location.

The relevant information that can be extracted from the parameters includes system type, pipe fitting type, size, etc.

 Figure 24.5.1 – 3D View of Bend

24.5.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Types, materials, nominal diameters of pipe fittings.

3. Wrappings or insulations to pipe fittings (if any).

4. Painting to pipe fittings (if any).
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24.5.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of pipe fittings, create a schedule with the following fields, sorted by system type, family & size, and 

summed up by groups:

Note:

• There is an alternative rule in HKSMM5 that for above ground water supply and disposal systems all pipe fittings  

> 110 mm nominal diameter are enumerated (instead of as extra over), and drainpipe is measured along the centre 

lines of pipes only (i.e. not measured through pipe fittings).

• For projects with full BIM information for pipework and fittings, suggest adding a special preamble for measuring all 

sizes of pipework along the centre lines of pipes only (i.e. not measured through pipe fittings), and all pipe fittings 

are enumerated.

• Refer to sections 24.3.3 and 24.4.3 above.

Adjust for the following as necessary:

• See Note in 24.5.3 above.
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24.6 PIPE ACCESSORIES

24.6.1 BASIC MODELLING APPROACHES

Based on the pipe accessories template, create a loadable family type for each type and size of accessories, and place 

the individual object in the designed location.

The relevant information that can be extracted from the parameters includes system type, pipe accessory type, size, 

etc.

 Figure 24.6.1 – 3D View of P Trap
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24.6.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Types, materials and nominal sizes of pipe accessories.

3. Painting to pipe accessories (if any).

24.6.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of pipe accessories, create a schedule with the following fields, sorted by system type, family & size, 

and summed up by groups:

Note:

• According to HKSMM5, pipework is not measured through pipe accessories and ancillaries, and this matches 

Revit’s measurement.

Adjust for the following as necessary:

• Nil.
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SECTION 25 – MECHANICAL SYSTEMS

25.1 DUCTWORK

25.1.1 BASIC MODELLING APPROACHES

Based on the ducts template, create a system family type for each type and cross-sectional size of ducts with routing 

set for different sizes and fittings, and place the individual object in the designed location to the required alignment and 

length.

The relevant information that can be extracted from the parameters includes system type, ductwork type, size, length, 

etc.

 

 
 Figure 25.1.1 – 3D View of Ductwork
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25.1.1 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Types, materials, qualities, cross-sectional dimensions and gauge or thicknesses of ductwork.

3. Wrappings & insulations/linings to ductwork (if any).

4. Painting to ductwork.

5. Specification.

25.1.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of ductwork, create a schedule with the following fields:

Note:

• In HKSMM5, the rates for mechanical systems cover setting and fixing in position on any background.

• Ductwork rectangular in section is measured the nett area of sheet material fabricated over all in-line fittings, short 

running, and branches, but not through in-line equipment.

• Ductwork circular or oval in section is measured along the centre lines of the duct and in-line fittings but not 

through in-line equipment. In-line fittings are measured extra over the circular or oval ducts.

• Where an in-line reduction in size occurs at a reducer or tee etc., the largest size shall be measured for the full 

length of the fitting.

• For projects with full BIM information for ductwork and fittings, suggest adding a special preamble for measuring all 

ductwork along the centre lines of ducts but not through in-line fittings; and all in-line fittings are enumerated.

Adjust for the following as necessary:

• See Note in 25.1.3 above.
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25.2 DUCT FITTINGS

25.2.1 BASIC MODELLING APPROACHES

Based on the duct fittings template, create a loadable family type for each type and size of duct fittings to be placed 

automatically when connecting two ducts or turning a duct, or placed manually.

The relevant information that can be extracted from the parameters includes system type, duct fitting type, size, etc.

 
  

Figure 25.2.1 – 3D View of Duct Fitting

For Duct Width, Height, Angle and Center Radius 

of the duct fittings, Shared Parameters should be 

created for scheduling.
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25.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Duct marks.

3. Types, materials, qualities , cross-sectional dimensions and thicknesses of duct fittings.

4. Wrappings & insulations/linings to duct fittings (if any).

5. Painting to duct fittings.

6. Specification.

25.2.3 QUANTITY TAKE-OFF GUIDELINES

(A) For measurement of rectangular duct fittings, create a schedule with the following fields:

Note:

• “Centre Radius multiplier” is given in the type name, being 1.5 times of duct width (W).

• “Duct Length” from default parameters should not be used to calculate the actual length of ductwork.

• Based on HKSMM5, rectangular ductwork is measured the nett area of sheet material fabricated over all in-line 

fittings, short running and branches.

• For calculating nett area of sheet materials of this fitting, set the following formulae:

Duct Fitting Length (along centre line) = 2π * (1.5 * Duct_Width) * (Bend_Angle/360o)

Duct Fitting Nett Area = 2 * (Duct_Width + Duct_Height) * Duct Fitting Length



209BIM Measurement Information Requirements 

(B) For measurement of circular or oval duct fittings, create a schedule with the following fields:

Note:

• “Centre Radius multiplier” is given in type name, being 1.5 times of duct diameter.

• “Duct Length” from default parameters should not be used to calculate the actual length of ductwork.

• Based on HKSMM5, circular ductwork is measured along the centre lines of ducts and in-line fittings, with extra 

overs in-line fittings being enumerated.

• For calculating the length of fittings, set the following formulae:

Duct Fitting Length = 2π * (1.5 * Duct_Diameter) * (Bend_Angle/360o)

It is suggested that:

• For projects with full BIM information for ductwork and fittings, add a special preamble for measuring all ductwork 

along the centre lines of ducts (i.e. not measured through in-line fittings), and all in-line fittings are enumerated.

Adjust for the following as necessary:

• Nil.
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25.3 DUCT ANCILLARIES

25.3.1 BASIC MODELLING APPROACHES

Based on the duct accessories template, create a loadable family type for each type and size of duct ancillaries, and 

place the individual object in the designed location.

The relevant information that can be extracted from the parameters includes system type, duct accessory type, size, 

etc.

 
 Figure 25.3.1 – 3D View of a Duct Damper
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25.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Duct ancillary types.

3. Types, materials, qualities, and sizes of duct ancillaries.

4. Wrappings & insulation/lining to duct ancillaries (if any).

5. Painting to duct ancillaries.

6. Specification.

25.3.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of duct ancillaries, create a schedule with the following fields:

Adjust for the following as necessary:

• Nil.
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SECTION 26 – ELECTRICAL SYSTEMS

26.1 CABLE TRAYS

26.1.1 BASIC MODELLING APPROACHES

Based on the cable trays template, create a system family type for each type and cross-sectional size of cable trays 

with routing set for different sizes and fittings, and place the individual object in the designed location to the required 

alignment and length.

The relevant information that can be extracted from the parameters includes cable tray type, size, length, etc.

 

 
 Figure 26.1.1 – 3D View of Cable Tray
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26.1.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Cable tray types.

3. Types, materials, qualities and cross-sectional dimensions of cable trays.

4. Painting to cable trays (if any).

26.1.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of cable trays, create a schedule with the following fields:

Note:

• According to HKSMM5, trays are measured along the centre line over all fittings, short lengths, and branches.

• Fittings > 200mm wide are measured as extra over trays. There is an alternative rule that such tray fittings are 

not measured separately but are included under trays. Notwithstanding this, the measurement of trays remains 

unchanged.

• For projects with full BIM information for trays and tray fittings, suggest adding a special preamble for measuring all 

trays along the centre lines of the trays but not measured through tray fittings; and all tray fittings are enumerated 

separately but not as extra over trays.

• Express statements required: The alternative rules apply only if expressly so stated.

Adjust for the following as necessary:

• Nil.
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26.2 TRAY FITTINGS

26.2.1 BASIC MODELLING APPROACHES

Based on the tray fittings template, create a loadable family type for each type and size of tray fittings to be placed 

automatically when connecting two cable trays or turning a tray, or placed manually in the designed location.

The relevant information that can be extracted from the parameters includes tray fitting type, size, etc.

 

 
 Figure 25.2.1 – 3D View of Cable Tray Fitting
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26.2.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Materials, qualities and sizes of tray fittings.

3. Sizes of tray fittings.

4. Painting to tray fittings (if any).

26.2.3 QUANTITY TAKE-OFF GUIDELINES

For measurement of tray fittings, create a schedule with the following fields:

Note:

• “Tray Length” from default parameters should not be used to calculate the actual length of tray.

• For Bends, shared parameters “Bend Radius (Centerline)” & “Fitting Bend Angle” are added for scheduling.

• Set the following formula to calculate the fitting lengths to be added to tray lengths:

Fitting Length (along centre line) = 2π * (Bend Radius (Centerline)) * (Fitting Bend Angle / 360o)

• For Tees, shared parameters “Tee Straight Length” and “Tee-out length” are added to extract the length. See the 

diagram below:
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Figure 26.2.1 – Plan of Tray Fitting Family

• For projects with full BIM information for trays and tray fittings, suggest adding a special preamble for measuring all 

trays along the centre lines of the trays but not measured through tray fittings; and all tray fittings are enumerated.

Adjust for the following as necessary:

• Nil.
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26.3 TRUNKING

26.3.1 BASIC MODELLING APPROACHES

Based on the ducts template, create a system family type for each type and cross-sectional size of trunking, and place 

the individual object in the designed location to the required alignment and length.

The relevant information that can be extracted from the parameters include trunking type, size, length, etc.

 
 Figure 25.3.1 – 3D View of Cable Trunking
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26.3.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Types, materials, qualities and cross-sectional dimensions of trunking.

3. Numbers and sizes of compartments.

4. Types of covers.

5. Painting to trunking (if any).

26.3.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of trunkings, create a schedule with the following fields:

Note:

• According to HKSMM5, trunking is measured along the centre line over all trunking fittings, short lengths, and 

branches.

• Fittings > 200 mm wide or high are measured as extra over trunking. There is an alternative rule that such trunking 

fittings are not measured separately but are included under trunking. Notwithstanding this, the measurement of 

trunking remains unchanged.

• For projects with full BIM information for trunking and trunking fittings, suggest adding a special preamble for 

measuring all trunkings along the centre lines of the trunkings but not measured through trunking fitting; and all 

trunking fittings are enumerated.

Adjust for the following as necessary:

• Nil.
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26.4 TRUNKING FITTINGS

26.4.1 BASIC MODELLING APPROACHES

Based on the duct fittings template, create a loadable family type for each type and size of trunking fittings to be 

placed automatically when connecting two trunkings or turning a trunking, or placed manually in the designed location.

The relevant information that can be extracted from the parameters includes system type, trunking fitting type, size, 

etc.

 

 
 Figure 26.4.1 – 3D View of cable trunking fitting
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26.4.2 INFORMATION REQUIREMENTS FOR QUANTITY TAKE-OFF

1. System types.

2. Trunking fitting types.

3. Types, materials, qualities and sizes of trunking fittings.

4. Painting to trunking fittings (if any).

26.4.3 QUANTITY TAKE-OFF GUIDELINES

For the measurement of trunking fittings, create a schedule with the following fields:

Note:

• According to HKSMM5, the gap length at trunking fittings must be added to the Revit trunking lengths to get the 

SMM compliant quantities.

• Add shared parameters “Tee Straight Length” and “Tee-out length” to report the dimensions of the fittings. The 

length calculated should be added to the trunking length.

Figure 26.4.2 – Plan of fitting family

• For projects with full BIM information for trunkings and trunking fittings, suggest adding a special preamble for 

measuring all trunkings along the centre lines of the trunkings (i.e. not measured through trunking fittings), and all 

trunking fittings are enumerated.

Adjust for the following as necessary:

• Nil.
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SECTION 27 – SCHEDULES AND MATERIAL TAKE-OFF SCHEDULES

Part C – Essential Skills in Creating Schedules, Quantity 
Extraction and Generation from BIM Models

In Revit, Schedules/Material Take-off Schedules are used for extracting information and dimensions/quantities of model 

elements. Only Material Take-off Schedules can extract the material quantities of the elements, e.g., the area applied by the 

Modify > Paint tool.

27.1 CREATE SCHEDULES

27.1.1 Click View > Schedules > Schedules/Quantities:

 

 

27.1.2 Select the required category of the new schedule, e.g., Select “Structural 
Framing”:

Scroll down
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27.1.3 Select available fields to be included in the schedule:

A. Add/Remove parameters:

a. Add the required parameters: Double click the required parameter in “Available fields” column 

or click the required parameter in “Available fields” column and then click the  button.

b. Remove unwanted parameters: Double click the unwanted parameter in “Schedule fields” 

column, e.g., “Volume” or select the unwanted parameter in “Scheduled fields” column and 

then click the  button.

(i) 
(ii) 

B. Include elements in linked files:

If there are linked files in the model, select “Include elements in links” to include the elements from 

the linked files into the schedule:
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C. Create a new parameter:

For a parameter that cannot be found in the “Available fields” column, it can be created in the 

schedule, e.g., Add “Concrete grade” to the schedule.

a. Click the “New parameter” button  :

 

b. Complete the information for the new parameter:

(ii)

(v)

(i)

(vi)

(vii)

(iii)
`

(iv)
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(i) Select the parameter type (project parameter or shared parameter).

Note: Project parameters are specific to a single project file and are used for scheduling, 

sorting, and filtering in a project, but cannot be tagged. Shared parameters can be 

used in multiple families or projects, and can be tagged and scheduled.

(ii) Input the name of parameter.

(iii) Select the discipline of parameter to be assigned.

(iv) Select the type of parameter.

Note: The type of parameter is chosen based on the selected discipline. For example, 

“Text” is for data information.

(v) Select the parameter to be grouped.

(vi) Select the type of properties.

Note: Type property is a value same to all elements in a family. Changing the value of a 

type property affects all current and future instances of that family type. Instance 

properties can be assigned to all elements of a particular family type, and the 

values of instance properties may vary. Changing the value of an instance property 

affects the selected element only.

(vii) Click the OK button  to confirm. The new parameter will appear in the scheduled 
fields:
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D. Create calculated value:

In the schedule, parameters can be created with setting formula. To set up the formula, required 

parameters have to be selected to the “Scheduled fields” column.

e.g., Create “Formwork of Beam” by setting formula “Cut Length * (Beam Width + Beam Depth * 2 

– [q Slab Thickness (1)] – [q Slab Thickness (2)])”. “q” is a prefix to denote a parameter set by QS.

a. Click “Add calculated parameter” :

 

b. Complete the information of “Calculated Value”:

 

(i) 
(ii) 

(iii) 
(iv) 

(v) 

(i) Input the new name of the parameter, e.g., “Formwork of Beam”.

(ii) Click Formula .

(iii) Choose the suitable discipline, e.g., Select “Common”:
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(iv) Choose the suitable type, e.g., Select “Length”:

 

(v) Input Formula:

• Click the button :

 

• Select the required fields for formula set up. Only the fields added to the scheduled 

fields can be selected for creating formula.

e.g., Select “Beam Depth”, “Beam Width”, “q Slab Thickness (1)”, “q Slab 

Thickness (2)” and “Cut Length”.

`

• Add corresponding symbol(s) e.g., “*”, “+”, “-“, to the appropriate positions:

 

• Once the formula set-up is completed, click “OK” of the Calculated Value.
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• The new parameter “Formwork of Beam” is created and shown in the scheduled 

fields:

 

E. Change order of selected fields:

The order of parameters shown in the schedule is based on the order in the scheduled fields. To 

change the order of selected fields, one can use “ ” and “ ” for movement. e.g., select “Formwork 

to Beam” and move it to above “Volume”:

 

F. To complete the selection of fields, click “OK”.
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27.1.4 The new schedule, e.g., “Structural Framing Schedule” is created:

27.1.5 Rename schedules:

The original naming of schedules is based on its category. After a schedule is created, the name of schedule 

can be changed for specific usage.

A. Select the new created schedule in the Project Browser:

• “Project Browser” > “Schedules/Quantities” > “Structural Framing Schedule”:
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B. Right-click the rename button and select “Rename…”:

C. Rename the schedule (e.g., rename to “Beam_Concrete and Formwork Schedule”) > “OK”.
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The schedule is renamed to “Beam_Concrete and Formwork Schedule”:
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27.2 CREATE MATERIAL TAKE-OFF SCHEDULES

27.2.1 Click “View” > “Schedules” > “Material Take-off”:

 

 

27.2.2 Select the required category of the new Material Take-off, e.g., Select 
“Structural Framing”:

 

 Double click Structural Framing 
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27.2.3 Select available fields to be included in the Material Take-off Schedule:

Add the required parameters from “Available fields” column to “Scheduled fields” column. At least one 

material field must be selected to Material Take-off Schedule, e.g., Material: Name/Material: Area.

Double click the selected parameter in the “Available fields” column, or click the selected parameter in the 

“Available fields” column and click the  button:

(a)

(b)

Refer to Section 27.1.3 for details of selecting available fields, adding new parameters and Calculated Value 

with formula.

After added/created the required parameters, click “OK”.

27.2.4 The new Material Take-off Schedule is created:

 

27.2.5 Rename Material Take-off Schedules:

The Material Take-off Schedule can be renamed for specific usage. Refer to Section 27.1.5 for details.
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27.3 FUNCTIONS OF SCHEDULES/MATERIAL TAKE-OFF SCHEDULES

27.3.1 Use “Filter” of Schedules:

Filter can be used to sort out the elements with specific parameters/requirements.

A. Select the desired schedule in project browser and open the schedule.

B. Click the “Edit” button against Filter in the Properties pallet of Schedule:

 

C. Set the filter requirements for parameters in the schedule:

(a)
(b)

(c)

(d)

a. Filter by “Reference Level”.

b. Select “equals”.

c. Select “8/F”.

d. “OK”.
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The schedule is filtered by “Reference Level – 8/F”:

 

 

 

27.3.2 Use “Sorting/Grouping” of Schedules:

Sorting/Grouping can be used to sort/group the elements by the selected parameters:

A. Select the desired schedule in project browser and open the schedule.

B. Click the “Edit” button under Sorting/Grouping in the Properties pallet of Schedule:
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C. Select a field for sorting/grouping (e.g., sort by “Reference Level” and calculate the total no. of 

elements):

(a)

(b)

a. Sort by: “Reference Level” (for sorting).

b. Tick “Grand totals:” (for grouping) > click “OK”.

D. The schedule is sorted by “Reference Level” and the total number of elements is shown at the 

bottom:

 
⭍ 
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27.3.3 Use “Formatting” of Schedules:

Formatting can be used to set specific format/setting to the schedule:

A. Select the desired schedule in project browser and open the schedule.

B. Click the “Edit” button under Formatting in the Properties pallet of Schedule:
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C. Format the schedules:

a. Hide unwanted field:

(e.g., fields used for creating formula only):

 

(i) 

(ii) 

(iii) 

(i) Select the unwanted field (e.g., “q Slab Thickness (1)”).

(ii) Tick the box “Hidden field”.

(iii) “OK”.

The selected field “q Slab Thickness (1)” will not show in the schedule:
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b. Align the field to center:

 

(a) 

(b) 

(c) 

(i) Select the field(s) to be aligned (e.g., “Reference Level”).

(ii) Select “Center” under Alignment.

(iii) “OK”.

The “Reference Level” is aligned to “center”:
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27.3.4 Use “Appearance” of Schedules:

A. Select the desired schedule in project browser and open the schedule.

B. Click the “Edit” button under Appearance in the Properties pallet of Schedule:

 

C. Select appropriate appearance for the Schedules/Material Take-off Schedules:

 

 (a) 

 (b) 

(i) Select the style of grid line/outline.

(ii) Select the text style for the title, header and body.
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27.4 ADD DATA INFORMATION IN THE SCHEDULES

27.4.1 Add parameters to Individual Element:

Once the information of parameters is added in the schedule, the relevant fields shown in the Properties 

pallet will be updated, e.g., add “Conc grade 60/20” for beam mark B8-01.

A. Click the beam Mark B8-01 in schedule.

B. Type “60/20” under parameter “q Conc grade”:

 

(a) (b) 

The information of the parameter is updated to the Properties pallet automatically. Such kind of adding 

information in models by QS should be done in the models for QTO only.
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27.4.2 Add parameters to a Group of Element/Category:

A. Select a beam and use short cut key “SA” to select all instances of beam:

 

B. Add Concrete grade “60/20” under parameter “q Conc grade” in the Properties:

 

The information under parameter “q Conc grade” will be updated automatically in the existing schedule:
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27.5 GENERATE SCHEDULE TEMPLATES

27.5.1 Once the schedules are created and developed, they can be saved as 
template and copied to other projects.

27.5.2 Select the desired schedules in existing project.

• “Project Browser” > “Schedules/Quantities” > Desired Schedule (e.g., “Structural Framing Material 

Take-off Schedule”).

27.5.3 Save the schedule by right-click mouse and select “Save to New File…”:
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27.5.4 Select the desired location to save:

 

27.6 COPY SCHEDULES

27.6.1 There are three options for copying schedules from template or project. 
Once the schedules/schedule templates are copied to the new project, 
the information shown in the schedule will be updated automatically 
based on the new project.

27.6.2 Insert schedules from template (Option 1):

A. “Insert” > “Insert from File” > “Insert Views from File”:
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B. Select the schedule template:

Select the saved template > “Open”:

 

File contains 
schedule only 

C. Select and tick the previous schedules to copy to the new project > “OK”:
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The selected schedules have been copied to the new project:

Schedules copied from the 
template/previous project

27.6.3 Insert schedules from previous project: (Option 2)

A. “Insert” > “Insert from File” > “Insert Views from File”.
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B. Select the previous project:

Select the saved previous project > “Open”:

 

File contains all 
information of project 
including schedules 

C. Select and tick the previous schedules to copy to the new project > “OK”:
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The selected schedules have been copied to the new project.

Schedules copied from the 
template/previous project



248 BIM Measurement Information Requirements 

27.6.4 Copy schedules from previous project (Option 3):

A. Open the previous project.

B. Select the required schedule(s) in Project Browser:

e.g., Select schedules named “B1_Beam_Concrete and Formwork Schedule, C1_Column 

Concrete and Formwork Schedule, S1_Slab Concrete and Formwork Schedule and W1_Wall 

Concrete and Formwork Schedule”:
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C. Right-click mouse and select “Copy to Clipboard”:

 

D. Open the new project.

E. Paste the copied schedules by “Modify” > “Paste” > Select “Paste from Clipboard”:
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The schedules have been copied to the new project:

   

Schedules copied from 
the previous projects

27.7 EXPORT DATA INFORMATION FROM REVIT

27.7.1 There are two common approaches to extract the data information from 
Revit to other file types for further processing. The first one is to export the 
Revit schedules as a CSV file, or a text file and then copy to Excel, and 
the other one is using a plug-in, such as Dynamo.
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27.7.2 Export to Excel file

Once the schedules/material take-off schedules are created in Revit, the information in schedules/material 

take-off schedules can be exported as a CSV# file and opened in Excel or as a text file and copied to 

Excel for further manipulation. However, all formulae created in the schedule cannot be transferred to Excel 

and all information is displayed as a text only.
# (P.S.: Revit 2022 supports exporting information in schedules as CSV files)

A. Export the schedule:

(a)

(b)

(c)
(d)

(a) Click  at the top-left corner to open the application menu.

(b) Select  “Export” button.

(c) Select  “Reports” in ribbon.

(d) Select  “Schedule”.
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B. Save the schedule as .txt file:

(a)

(b)

(c)

(a) Select the desired folder.

(b) Add the file name. The file only can be saved as “txt” format.

(c) Click “Save” button.

(d) Another window of “Export Schedule” will pop up. Click “OK”:

(d)

Normally there is no change 
to the default setting
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C. Use Excel to open the .txt file:

(a) Open a new Excel file.

(b) Select “Open Other Workbooks”.

(c) Select “Browse”:

(a)

(c)(b)

(d) Click arrow at right bottom corner of the Excel window.

(e) Select  and “Open”:

(d)

(e)
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(f) Select the saved “.txt” file for the Revit schedule:

 

(f) 

(g) A window of “Text Import Wizard – Step 1 of 3” will pop up. It can use the default setting. Click 

 button to the next step:
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(h) A window of “Text Import Wizard – Step 2 of 3” will pop up. It can use the default setting. Click 

 button to the next step:

 

(i) A window of “Text Import Wizard – Step 3 of 3” will pop up. It can use the default setting. Click 

 button to finish the step:
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The file of Revit schedule in “.txt format” is transferred to Excel:

 

 

 

Note: All information transferred to Excel is a text only. The formula created in Revit Schedule cannot be 

transferred to Excel. Moreover, there is no linkage between the information transferred to Excel and 

the original Revit Schedule.

27.7.3 Dynamo

Dynamo is a plug-in and an open-source visual programming language for Autodesk Revit. It is a program 

created by code block, nodes and Python. Dynamo can be used for analyzing complex geometries, 

automating repetitive processes and exporting data to Excel files and other file-types.

For BIM QTO, quantity surveyors can extract data from BIM models to Excel files by Dynamo. Once the 

Dynamo scripts are created, they can be saved as templates and applied to another project. Updates on the 

dynamo scripts may be required to suit individual project needs.

An introduction to the operation of using Dynamo for extracting information from Revit models is provided in 

the following section – Section 28.
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SECTION 28 INTRODUCTION TO DYNAMO

28.1 DYNAMO IN REVIT

28.1.1 Dynamo is a Visual Programming add-on native in Revit. It was engineered for building designer to automate 

the design process in a parametric way. Unlike the traditional add-on / plug-in development, Dynamo provides 

an intuitive interface for ordinary user to automate their process while still retains its potential to high-level 

programming using IronPython. The essential features are:

28.1.2 Nodes:

Nodes are pre-defined set of programming script. There are different types of nodes, e.g., Built-in Node, Custom 

Node, Node from Packages:

A. Built-in Node refers to those came out-of-box with Dynamo and Revit.

B. Custom Node are built by users. It can be built by grouping Built-in Nodes, using code block, or using 

IronPython at its core.

C. Packages are set of custom nodes prepared by Dynamo experts around the globe and shared on online 

community.

By connecting various nodes to create complex algorithm, data are being extracted, calculated, interpolated and 

re-structured to users’ requirements. Nodes usually are self-explanatory and further supplemented with explanatory 

note. The Node approach save users from programming syntax and thus having a mild learning curve.

28.1.3 List:

Another fundamental concept of Dynamo is List management. All data are organized in list. With tiers of list, data 

are grouped and chained for processing:
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Users can specify the target tier of list for the function to act on. With combination of different tiers, users can 

perform a function on all data in one list against data in another, thus vice versa.

28.2 EXTRACT MODEL DATA TO EXCEL

28.2.1 An Overview:



259BIM Measurement Information Requirements 

28.2.2 Procedure:

A. Select Model elements by their Categories. For Piles in the sample RVT file, piles are drawn in Structural 

Foundation Category.

B. The result returned from the selection nodes contains elements other than piles. It is essential to filter out 

un-intended elements before moving onto the next steps:
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C. After the filtering process, the element list on hand is a clean list of pile elements. Then, information stored 

in different parameters can be located and extracted. Parameter names must be exacted and are case-

sensitive.



261BIM Measurement Information Requirements 

D. Each Get Parameter node will return a list of values based on the list of elements input. Multiple lists 

must be merged into one list for exporting to Excel. Dynamo plots data in each list to Excel in a horizontal 

manner. To get data presented in the comma fashion, we need to transpose the list before exporting.

E. Finally, the data are directed into the export to Excel node:
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28.3 CALCULATE DATA FROM GEOMETRY

28.3.1 An Overview:
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28.3.2 Procedure:

A. Select and filter piles:

B. Get all horizontal surfaces’ geometry:
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C. Filter the centre topmost surface of piles:

D. Generate Topography PolySurface:

E. Project all centre onto the Topography to get the existing ground level of each pile:
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F. Generate a line connecting the Center Point and Projected Point. The line is painted in RED:
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